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Chapter _


(GBR) Using Student Loans Company


Common Elements Used in Student Loans Company


HEI Code (higher education institution
code)


Select the code for which you want to load the data.


The prompt view restricts the values from which you can select
to those found in the Student Loans Company Setup component.


SLC Acad Year (Student Loans
Company academic year)


Select the SLC academic year for which you want to load the
data.


The prompt view restricts the values from which you can select
to those found in the Student Loans Company Setup component.


File Path and Name Enter one or more files to import.


If a file is not entered, the process considers only unprocessed
records.


Note: The definitions for HEI Code, SLC Acad Year, and File
Path and Name relate to importing files.


UCAS Course Code (Universities &
Colleges Admissions Service course
code)


Displays the UCAS code assigned to the course.


SLC Course Code (Student Loans
Company course code)


Displays the SLC code assigned to the course.


Year of Course Displays the year of the course in which student is currently
enrolled.


Course Tuition Fee Amt (course
tuition fee amount)


Displays the course fee that applies to the course.


Tuition Fee Loan Payable Displays the portion of the fee paid by TFL.


Tuition Fee Grant Payable Displays the portion of the fee paid by TFG.


Tuition Fee Student Payable Displays the portion of the fee that the SLC expects to be paid
directly by student.


Course Start Date Displays date that the student commenced the course.


Grant Payable Indicates whether the student is entitled to a supplementary
grant.
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Bank Details Held Indicates whether the student has supplied bank details.


Valid NINO Flag (valid national
insurance number flag)


Indicates whether the student has provided a valid national
insurance number or a valid reason for not supplying it.


Disabled Distance Learner Indicates whether the applicant is a distance learner due to a
disability.


Bursary Student Flag Indicates whether the student has a bursary.


FSN Status or Student Status Displays the student notification status as notified by the
awarding authority. Values are:


• B (Living Costs and Fees).


• L (Living Costs).


• F (Final).


• P (Provisional).


• D (Deceased).


• K (Resumption).


• N (Resumption).


• S (Suspended).


• T (Transfer fees to previous institution).


• V (Transfer fees to new institution).


• W (Withdrawn-final).


• Y (Withdrawn-provisional).


• Z (Study in second term only).


Student Support Nbr (student support
number)


Displays an identifier assigned by the SLC to a student who
applies for financial assistance.


Importing SSAR Files


This section provides an overview of SSAR files and discusses how to load SSAR files.


Understanding SSAR Files
After the SLC receives applications for financial assistance from students, the SLC sends SSAR
reports to the HEIs. These reports list individual students attending the HEI and include biographic and
demographic data, information about the students' courses of study, and the amount of Tuition Fee Grant
(TFG) and Tuition Fee Loan (TFL) assistance that each student can expect. The amounts for the TFG and
TFL are used to offset students' tuition fee charges.
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SSAR reports require a response from the HEI in the form of an SSAC.


When you import the Registration Confirmation report (SSAR) from the SLC, the filename is defaulted
to 'Registration Confirmation Report', and the sequence number field is zeros. Overwrite the file name
before saving or importing the file into your system. Ensure that the file is always imported with a unique
name as per the naming convention. Do not re-import the same data or the same data file more than once
either with same file name or a different file name.


The Import SSAR File process:


1. Loads data into a staging table.


2. Attempts to match on Student Support Number (SSN).


If a match exists, the record is loaded to the application table for use in the system. A student
with a match is aid-year activated for the aid year selected in the Student Loans Company Setup
(SFA_SLC_SETUP) component.


Page Used to Load SSAR Files
Page Name Definition Name Navigation Usage


Import SSAR Files SFA_SLC_RC_SSAR Financial Aid > Student
Loans Company > Import
SSAR Files > Import SSAR
Files


Load SSAR files.


Loading SSAR Files
Access the Import SSAR Files page (Financial Aid > Student Loans Company > Import SSAR Files >
Import SSAR Files).


Image: Import SSAR Files page


This example illustrates the fields and controls on the Import SSAR Files page. You can find definitions
for the fields and controls later on this page.
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File Path and Name Enter the location of the file to be imported. The file name must
be unique.


Warning! Do not attempt to reload a file with the same data or
the same file name.


Managing SSAR Suspensions


This section provides an overview of SSAR suspensions and discusses how to review and manage
unmatched or unprocessed SSAR data.


Understanding SSAR Suspensions
Use the Manage SSAR Suspense (SFA_SLC_SSAR_DTL) component to review and manage unmatched
or unprocessed SSAR data.


The system does not provide an option for adding a new person to the system as a result of reviewing
unmatched or unprocessed data.


Also, this process does not update Campus Community Person biographic and demographic data.


Page Used to Review and Manage Unmatched or Unprocessed SSAR Data
Page Name Definition Name Navigation Usage


Manage SSAR Suspense SFA_SLC_SSAR_DTL Financial Aid > Student
Loans Company > Manage
SSAR Suspense > Manage
SSAR Suspense


Review and manage
unmatched or unprocessed
SSAR data.


Reviewing and Managing Unmatched or Unprocessed SSAR Data
Access the Manage SSAR Suspense page (Financial Aid > Student Loans Company > Manage SSAR
Suspense > Manage SSAR Suspense).
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Image: Manage SSAR Suspense page (1 of 2)


This example illustrates the fields and controls on the Manage SSAR Suspense page (1 of 2). You can
find definitions for the fields and controls later on this page.


Image: Manage SSAR Suspense page (2 of 2)


This example illustrates the fields and controls on the Manage SSAR Suspense page (2 of 2). You can
find definitions for the fields and controls later on this page.


After a match is identified, you can load the data in the Student SLC Data table used for SSAC generation
and award packaging.


Status If the status is Processed, you can only view the field.


If the status is one of the following values, you can select a
different value and click Save to update the SSAR status:


• Skipped: This record will not be considered for matching in
any future runs of the Import SSAR Files process.


• Suspended: No match was found for this record. The record
will be considered for matching the next time that the Import
SSAR Files process is run.
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• Unprocessed: The record will be considered for matching
the next time that the Import SSAR Files process is run.


You can update students with a Skipped status to Unprocessed
so they can be considered for matching the next time that the
Import SSAR Files process is run.


Search Match
Search Match Click this link to access the Person Search Match page and


search for a student ID to match the SSAR record.


ID The EMPLID of the existing person with whom you want to
match this record.


ID Lock After you enter an ID, select this check box to force the SSAR
load process to use the ID.


Use Search/Match ID Click this link to populate the ID field with the result from the
Person Search/Match.


Process SSAR (process Student
Support Attendance Requests)


Click to force the SSAR record to be matched with the EmplID
that you selected. If the match is successful, the SSAR record is
loaded. If the match is not successful, a message appears in the
page header message area:


• Student Not Found


• Multiple Student Matches Found


• Match Option Set to Suspend:  A match was found after
Search/Match was run, but the Search/Match rule set the
record to Suspended.


• ID Linked to Another SSN:  EmplID already has an external
ID type of SLC.


• SSN Linked to Another ID:  The SSN in this record is
already associated with an EmplID.


Max Match Level (maximum match
level)


Displays the highest Search Match Level rule that was met for
this SSAR record.


Matches Displays the number of matches found by the Search Match
process.


Course/SLC Data
Issue Date Displays the date that the SLC issued the SSAR to the HEI.


Loan Applied For Displays the type of loan for which the student applied. Values
are:


• F (Full Entitlement)


6  Copyright © 2018, Oracle and/or its affiliates. All rights reserved.







Chapter _ (GBR) Using Student Loans Company


• P (Part Entitlement)


• N (No loan applied for)


Generating SSAC Data


This section provides an overview of SSAC data and discusses how to:


• Add SSAC data manually.


• Generate SSAC data.


Understanding SSAC Data
SSARs can be received daily and are usually responded to the same day with an extract of data, the SSAC
file, that is sent back to SLC. Occasionally, schools may also need to include students for whom no SSAR
has been received in an SSAC extract. The SSAC confirms the physical attendance of each student on the
campus. The HEIs must ultimately record that a student has been seen and report that information to the
SLC in an SSAC file.


The receipt of the SSAC by the SLC authorizes the beginning of maintenance (living expense) payments
directly to the student by government authorities. This assistance is different from the TFGs and TFLs,
which are for tuition fees only and paid directly to the institution. The HEI does not determine what the
maintenance payments are and does not need to monitor these payments.


For a student to be automatically included in the SSAC extract, the student must:


• Have a SSAR record loaded.


• Have no previous SSAC processed.


• Be included in the selected Population Selection option.


• Meet requirements in the SLC setup:


• If the Use Physical Attendance Flag check box is selected on the Student Loans Company-
Options (setup) page, the Physical Attendance Confirmed check box must be selected for the
student on the SSAC page in the View SLC Student Data (SFA_SLC_STUDENT) component for
the student to be included in the SSAC extract.


• If a checklist is selected in the Use Checklist field on the Student Loans Company-Options (setup)
page, the student must have that checklist assigned and completed to be included in the SSAC
Extract.


If the Complete SSAR Checklist check box on the Student Loans Company–Options page is selected,
students who were assigned an SSAR Checklist during the Import SSAR Files process and are added to
the SSAC extract have their SSAR Checklists marked as complete.


For a student to be manually included in an SSAC extract, add the student to the SSAC Manual Entry
table using the Manual SSAC Manual Entry page.


Copyright © 2018, Oracle and/or its affiliates. All rights reserved. 7







(GBR) Using Student Loans Company Chapter _


Pages Used to Generate SSAC Data
Page Name Definition Name Navigation Usage


Manage SSAC Manual Entry SFA_SLC_SSACMAN Financial Aid > Student
Loans Company > Manage
SSAC Manual Entry >
Manage SSAC Manual Entry


Add a student manually for
inclusion in an SSAC extract
file.


Generate SSAC Data SFA_SLC_RC_SSAC Financial Aid > Student
Loans Company > Generate
SSAC Data > Generate
SSAC Data


Define SSAC parameters and
generate SSAC data in an
extract file.


Adding SSAC Data Manually
Access the Manage SSAC Manual Entry page (Financial Aid > Student Loans Company > Manage
SSAC Manual Entry > Manage SSAC Manual Entry).


Image: Manage SSAC Manual Entry page


This example illustrates the fields and controls on the Manage SSAC Manual Entry page. You can find
definitions for the fields and controls later on this page.


Use this page when you want to include a student in an SSAC extract but no SSAR record has been
received for the student.


Student Support Nbr (student support
number)


Add a new row and enter a student's SSN.


• If the SSN is already in the External System ID table, the ID
and name are automatically entered when you tab out of the
Student Support Nbr field.


• If the SSN is not in the system, you must manually enter the
ID. The name is automatically entered when you tab out of
the ID field. When the row is saved, the SSN is added to the
External System ID table for that student ID.
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The Attendance Confirmed Date, UCAS Course Code, SLC Course Code, and Course Year fields are
optional. If both a UCAS Course Code and SLC Course Code are entered, the UCAS Course Code is used
in the SSAC file.


When the Generate SSAC Data process is run, it includes any unprocessed SSAC manual entries in the
SSAC file that is created by the process. These entries remain on the Manage SSAC Manual Entry page in
view–only mode after being processed and included in an SSAC file.


When the Import SSAR Files process is run and SSAR data is imported for a student whose SSAC data
was entered manually, the process checks to see if a SSAC record exists. If the SSAC record does not
exist, the process creates a SSAC record using the manually entered SSAC data.


Generating SSAC Data
Access the Generate SSAC Data page (Financial Aid > Student Loans Company > Generate SSAC
Data > Generate SSAC Data).


Image: Generate SSAC Data page


This example illustrates the fields and controls on the Generate SSAC Data page. You can find definitions
for the fields and controls later on this page.


Use this page to create an extract file to send to the SLC to confirm a student's physical attendance.


The Population Selection process is used to determine which students are included in the SSAC extract
file that is sent to the SLC. The Population Selection group box appears if you select either the Populate
process option or the Populate and Export process option.


See "Queries for Population Selection" (PeopleSoft Campus Solutions 9.2: Campus Community).


See "Equations for Population Selection" (PeopleSoft Campus Solutions 9.2: Campus Community)


Input Parameters
Process Option Select a process option. Values are:


Copyright © 2018, Oracle and/or its affiliates. All rights reserved. 9







(GBR) Using Student Loans Company Chapter _


• Populate Only: Populate the SSAC table.


• Export Only: Create only an extract file of populated SSAC
data to send to the SLC.


• Populate and Export: Populate the SSAC table and create an
extract file of SSAC data to send to the SLC.


First Attendance Confirmation Select this check box to indicate that you want the SSAC report
to confirm attendance for the SLC First Liability Period.


File Path Enter the location for the extract file.


This field is activated if a value of Export Only or Populate and
Export is selected in the Process Option field.


The file path must end with a backslash (\).


Location Code Enter the location code for the specific location at the HEI. The
values range from 01 to 99.


Importing HEBSS Files


This section provides an overview of HEBSS files and discusses how to load HEBSS files.


Understanding HEBSS Files
HEIs in the United Kingdom can elect to participate in the HEBSS with the SLC. The scheme determines
student eligibility for and disburses various bursaries and scholarships.


Schools can choose to provide criteria to the SLC and let the SLC determine eligibility for and disburse
bursaries and scholarships on their behalf. Alternatively, schools might use financial circumstances data
collected by the SLC and included in the HEBSS report to determine bursary and scholarship eligibility
and disburse these funds to the students themselves. This report does not require a response from the HEI.


The Import HEBSS Files process:


1. Loads the data to a staging table.


2. Attempts to match on SSN:


• If a match exists, the record is loaded to an application table for use in the system.


• If no match exists, the process attempts a match using the Search Match Criteria page in the
Student Loans Company Setup component.


If a match is found, the record is loaded to the application table for use in the system.
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Page Used to Load HEBSS files
Page Name Definition Name Navigation Usage


Import HEBSS Files SFA_SLC_RC_HEBSS Financial Aid > Student
Loans Company > Import
HEBSS Files > Import
HEBSS Files


Load HEBSS files.


Loading HEBSS Files
Access the Import HEBSS Files page (Financial Aid > Student Loans Company > Import HEBSS
Files > Import HEBSS Files).


Image: Import HEBSS Files page


This example illustrates the fields and controls on the Import HEBSS Files page.


Managing HEBSS Suspensions


This section provides an overview of HEBSS suspensions and discusses how to review and manage
unmatched or unprocessed HEBSS data.


Understanding HEBSS Suspensions
Use the Manage HEBSS Suspense (SFA_SLC_HEBSS_DTL) component to review and manage
unmatched or unprocessed HEBSS data.


The system does not provide an option for adding a new person to the system as a result of reviewing
unmatched or unprocessed data.


Also, this process does not update Campus Community Person biographic and demographic data.
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Page Used to Review and Manage Unmatched or Unprocessed HEBSS Data
Page Name Definition Name Navigation Usage


Manage HEBSS Suspense SFA_SLC_HEBSS_DTL Financial Aid > Student
Loans Company > Manage
HEBSS Suspense > Manage
HEBSS Suspense


Review and manage
unmatched or unprocessed
HEBSS data.


Reviewing and Managing Unmatched or Unprocessed HEBSS Data
Access the Manage HEBSS Suspense page (Financial Aid > Student Loans Company > Manage HEBSS
Suspense > Manage HEBSS Suspense).


Image: Manage HEBSS Suspense page (1 of 2)


This example illustrates the fields and controls on the Manage HEBSS Suspense page (1 of 2). You can
find definitions for the fields and controls later on this page.
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Image: Manage HEBSS Suspense page (2 of 2)


This example illustrates the fields and controls on the Manage HEBSS Suspense page (2 of 2). You can
find definitions for the fields and controls later on this page.


Note: For information about the Status field and the fields in the Search Match group box, refer to the
information provided about similar fields on the Manage SSAR Suspense page.


Identification
ART ID (Automated Response
Technology Identification)


The ART ID is an eleven-digit number that is used to uniquely
identify a student's SLC student finance account. It is
automatically issued when the student applies for financial
support.


Application/Award Information
Automated Award Total Displays the student's total approved automated award


entitlement as awarded by SLC using HEI rules.


Manual Award Total Displays the student's total approved manual award entitlement,
 which is manually entered in the SLC system by the HEI.


Overall Award Total Displays the student's total overall approved award entitlement.


Non-Means Test Indicates whether the student is applying for only non-means-
tested support.
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Evidence Verified Indicates whether all financial evidence has been received to
validate the student's application.


Income Assessed Funding Indicates whether the student has applied for income assessed
NHS funding.


Non-Income Assessed Funding Indicates whether the student has applied for non-income
assessed NHS funding.


Course Information
Course Type Displays the course type. Values are:


• ACCELERATED (Course compresses a two year course into
one year of study)


• ART TEACHER


• EMERGENCY


• FRANCHISED


• OTHER


• PART TIME


• PGCE (Post Graduate Certificate In Education)


Method of Attendance Displays the method of attendance. Values are:


• Full Time


• Part Time


• PGCE  (post graduate)


Qualification Displays the qualification achieved upon course completion.


Commence Year The year that the student commenced studying.


Importing ACR and SISF Files


This section provides an overview of ACR and SISF files and discusses how to load ACR and SISF files.


Understanding ACR and SISF Files
The ACR and SISF files contain TFG and TFL information for individual students.


The ACR file requires a response from the HEI to the SLC. When the HEI responds, it confirms student
data to the SLC, including attendance and course of study information. These files are sent to the HEI
from the SLC starting in December of each academic year.
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The SISF file is informational only and does not require a response from the HEI. It is sent to the HEI
from the SLC in October and November of each academic year.


Use the Import ACR/SISF (SFA_SLC_RC_ACR) component to set up and run the batch import of ACR/
SISF files.


The process looks at the value in the File Type field to identify the type of file that is being imported.


The Import ACR/SISF process:


1. Loads the data into a system table.


2. Attempts to match on SSN:


• If a match exists, the record is loaded to the application table for use in the system.


• If no SSN match exists, the process attempts to match using Search/Match criteria designated in
Student Loans Company Setup component.


If a match exists, the record is loaded to the application table for use in the system.


Page Used to Load ACR and SISF Files
Page Name Definition Name Navigation Usage


Import ACR/SISF SFA_SLC_RC_ACR Financial Aid > Student
Loans Company > Import
ACR/SISF > Import ACR/
SISF


Load ACR and SISF files.


Loading ACR and SISF Files
Access the Import ACR/SISF page (Financial Aid > Student Loans Company > Import ACR/SISF >
Import ACR/SISF).


Image: Import ACR/SISF page


This example illustrates the fields and controls on the Import ACR/SISF page. You can find definitions
for the fields and controls later on this page.
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ACR/SISF Parameters
File Type The Import ACR/SISF process uses the value that you select in


the File Type field to identify the imported file as Attendance
Confirmation Reqst, Extended SISF, or Student Information
Service.


Liability Period Select the Liability Period for which you want to import
ACR data. This field is required if you select a File Type of
Attendance Confirmation Reqst,


Managing ACR and SISF Suspensions


This section provides an overview of ACR and SISF suspensions and discusses how to review and
manage unmatched or unprocessed ACR and SISF data.


Understanding ACR and SISF Suspensions
Use the Manage ACR/SISF Suspense (SFA_SLC_ACR_DTL) component to review and manage
unmatched or unprocessed ACR and SISF data.


The system does not provide an option for adding a new person to the system as a result of reviewing
unmatched or unprocessed data.


Also, this process does not update Campus Community Person biographic and demographic data.


Page Used to Review and Manage Unmatched or Unprocessed ACR and
SISF Data


Page Name Definition Name Navigation Usage


Manage ACR/SISF Suspense SFA_SLC_ACR_DTL Financial Aid > Student
Loans Company > Manage
ACR/SISF Suspense >
Manage ACR/SISF Suspense


Review and manage
unmatched or unprocessed
ACR and SISF data.


Reviewing and Managing Unmatched or Unprocessed ACR and SISF Data
Access the Manage ACR/SISF Suspense page (Financial Aid > Student Loans Company > Manage
ACR/SISF Suspense > Manage ACR/SISF Suspense).
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Image: Manage ACR/SISF Suspense page


This example illustrates the fields and controls on the Manage ACR/SISF Suspense page. You can find
definitions for the fields and controls later on this page.


Image: Manage ACR (Attendance Confirmation Report)/SISF (Student Information Service File)
Suspense page 2 of 2


This example illustrates the fields and controls on the Manage ACR (Attendance Confirmation Report)/
SISF (Student Information Service File) Suspense page 2 of 2.
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Note: For information about the Status field and the fields in the Search Match group box, refer to the
documentation about the similar fields on the Manage SSAR Suspense page.


File Type Displays the file type: Attendance Confirmation Reqst, Student
Information Service, or Extended SISF.


If the value is Extended SISF, the Extended SISF Data group
box appears.


Course/SLC Data
Course Start Period Displays the period when the course starts, for example AUT 


(Autumn).


Course Code Displays the UCAS code or SLC code that is assigned to the
course.


Student Status Date Displays the date that the student status was assigned or
updated.


New Record Indicates whether the record appeared on a previous ACR/SISF.


Revision Indicator Indicates whether the record has changed since a previous ACR/
SISF.


Attendance Indicator If an At Fee Code was returned in a previous ACR Response, it
appears here.


Running the ACR At Fee Evaluation Process


This section provides an overview of ACR At Fee Evaluation and discusses how to calculate the At Fee
Code for ACR records.


Understanding ACR At Fee Evaluation
Use the ACR At Fee Evaluation (SFA_SLC_RC_ACR_EQ) component to determine the At Fee Code to
be returned to the SLC in the file created by the ACR Export File process.


The ACR At Fee Evaluation process uses the File Type field to identify the imported file as ACR.


The ACR At Fee Evaluation process uses any equations defined in the ACR Processing group box in the
Student Loans Company Setup component to populate variables that can be used by the At Fee Equation
and also executes the At Fee Equation. The At Fee Equation populates a student's ACR Attendance
Indicator (on the ACR/SISF page), which determines what At Fee Code is returned to the SLC with the
ACR Response.
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Page Used to Calculate the At Fee Code for ACR Records
Page Name Definition Name Navigation Usage


ACR At Fee Evaluation SFA_SLC_RC_ACR_EQ Financial Aid > Student
Loans Company > ACR At
Fee Evaluation > ACR At
Fee Evaluation


Calculate the At Fee Code
value for ACR records.


Calculating the At Fee Code for ACR Records
Access the ACR At Fee Evaluation page (Financial Aid > Student Loans Company > ACR At Fee
Evaluation > ACR At Fee Evaluation).


Image: ACR At Fee Evaluation page


This example illustrates the fields and controls on the ACR At Fee Evaluation page. You can find
definitions for the fields and controls later on this page.


Liability Period Select a Liability Period. You can run this process for multiple
Liability Periods with the same Issue Date.


Issue Date Enter the issue date of the ACR file that you want to evaluate.


The following table describes the At Fee Code values as defined by the SLC:


At Fee Code Description


A HEI agrees that the student is in attendance for the attendance
date, course and course year shown and they agree with the
Course Tuition Fee amount and the Liability (combination
of Tuition Fee Loan and Student Pays). It is important that
the HEI ensure that the fee liability is correct, because using
code A results in the fee loan and/or grant showing on the
Attendance Confirmation Report as being paid.


C The student is in attendance at the institution but for a different
course and/or year of course to those shown on the schedule. 
(For example, the year of course is shown as 2 on the schedule
but the student is repeating the first year).


F Student is in attendance; however the HEI disagrees with the
course fee.
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At Fee Code Description


L Student is in attendance at the HEI, for the course and course
year indicated, however the HEI disagrees with the Liability 
(combination of Tuition Fee Loan and Student Pays) but
undertakes to make reparations to the student such that the
liability is correctly discharged and no overpayment of Tuition
Fee support to that institution exists.


N Student is in attendance at the HEI, for the course and course
year indicated, however the HEI disagrees with the Liability 
(combination of Tuition Fee Loan and Student Pays) but does
not undertake to make reparations to the student such that the
liability would be correctly discharged and no overpayment of
Tuition Fee support to that institution would exist.


X Student is not in attendance on the relevant attendance
date, except where the non attendance is due to the student
suspending their studies.


S Studies suspended.


Running the Calculate FTE Process


This section provides an overview of the Calculate FTE process for SLC.


Understanding the Calculate FTE Process
Use the Calculate FTE (SSR_HE_CALC_FTE) component to calculate students' full-time equivalent
enrollment for reporting via the ACR Response process.


In order to meet the reporting requirements of the SLC Attendance Confirmation Report (ACR) for part-
time students, institutions must calculate a value that represents the student’s academic load for the Aid
Year expressed as a percentage of full-time equivalence (FTE). A student who has been studying full-time
for the period is returned with an FTE of 100. A student studying part-time is returned with a value of less
than 100 to represent the proportion of full-time study they have undertaken. For example, a student with
half the load of a full-time student is returned with FTE of 50.


The FTE result is used by the Export ACR File process to determine whether the student with an
Academic Load of part-time meets the 25% FTE threshold for ACR reporting. The determination of Full
time and Part time Academic load is based upon the HESA Mode of Study value mapping.


Page Used to Calculate FTE
Page Name Definition Name Navigation Usage


Calculate Full-Time
Equivalence


SSR_HE_CALC_FTE Financial Aid > Student
Loans Company > Calculate
FTE > Calculate SLC FTE


Calculate FTE for students
for reporting with the ACR
response.
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Calculating FTE for SLC Reporting
Access the Calculate Full-Time Equivalence page (Financial Aid >Student Loans Company >Calculate
FTE >Calculate SLC FTE).


Image: Calculate Full-Time Equivalence page


This example illustrates the fields and controls on the Calculate Full-Time Equivalence page. You can
find definitions for the fields and controls later on this page.


This process uses the same FTE logic as the FTE process for student records with the addition of the SLC
FTE Parameters to determine if there is an ACR record which requires a response. For more information
about calculating FTE for HESA and SLC:
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See "Calculating Full-Time Equivalence for Students" (PeopleSoft Campus Solutions 9.2: Student
Records).


For this process to calculate the FTE for SLC ACR reporting properly, you should follow the set up
guidelines in the (GBR) Setting Up Student Loans Company.


In the SCL FTE Parameters group box, all 3 parameters, HEI Code, SLC Acad Year, and Issue Date are
required.


Related Links
Completing Prerequisites for SLC FTE Calculation


Exporting the ACR Response File


This section provides an overview of the ACR Response File and discusses how to export the ACR
Response File.


Understanding the ACR Response File
Use the Export ACR File (SFA_SLC_RC_ACR_EXP) component to create an extract file to send to the
SLC.


The Export ACR File process uses the File Type field to identify the record as ACR.


The Export ACR File process creates the ACR Response File using the values in the Attendance Indicator
field. This field contains the At Fee Code values.


The process does not export a SISF.


The process does not create a file for an ACR for which a previous response has been created.


Page Used to Export the ACR Response File
Page Name Definition Name Navigation Usage


Export ACR File SFA_SLC_RC_ACR_EXP Financial Aid > Student
Loans Company > Export
ACR File > Export ACR File


Export the ACR Response
file.


Exporting the ACR Response File
Access the Export ACR File page (Financial Aid > Student Loans Company > Export ACR File >
Export ACR File).
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Image: Export ACR File page


This example illustrates the fields and controls on the Export ACR File page. You can find definitions for
the fields and controls later on this page.


Issue Date Enter the issue date of the ACR file that you want to process.


Liability Period Select the SLC Liability Period for which you are reporting.


Academic Load Select the Academic Load that you are reporting: Full-time,
Part-time, Both, or None.


Admit Date Override Enter an alternative Admit Term Start Date here if you want to
export information for a part-time population with an Admit
Term Start Date prior to September 1, 2012. The Admit Date
Override field is activated when the selected Academic Load is
Part-time or Both.


File Path Enter a path to indicate where to store the extract file.


Enable Population Selection Select this check box to activate additional Population Selection
parameters if you want to define your own population selection
criteria for this process. This is optional.


Related Links
"Using the Population Selection Process" (PeopleSoft Campus Solutions 9.2: Campus Community)


Importing Remittance Report Files


This section provides an overview of Remittance Report files and discusses how to load Remittance
Report files.
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Understanding Remittance Report Files
Remittance reports are sent to the HEI from the SLC and correspond with the receipt of Tuition Fee
payments from the SLC to the HEI. These reports do not require a response from the HEI.


The major Remittance Report files are sent to the HEI from the SLC in February and April of each
academic year. The HEI might also receive additional Remittance Report files that contain adjustments to
the data that was previously sent.


Use the Import Remittance Report Files (SFA_SLC_RC_TFRA) component to load Remittance Report
files to a staging table and use them for reconciliation with system data.


Page Used to Load Remittance Report Files
Page Name Definition Name Navigation Usage


Import Remittance Report
Files


SFA_SLC_RC_TFRA Financial Aid > Student
Loans Company > Import
Remittance Report Files >
Import Remittance Report
Files


Load Remittance Report files.


Loading Remittance Report Files
Access the Import Remittance Report Files page (Financial Aid > Student Loans Company > Import
Remittance Report Files > Import Remittance Report Files).


Image: Import Remittance Report Files page


This example illustrates the fields and controls on the Import Remittance Report Files page.
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Viewing Remittance Staging Data


This section discusses how to view Remittance imported data.


Page Used to View Remittance Imported Data
Page Name Definition Name Navigation Usage


View Remittance Staging
Table


SFA_SLC_TFRA_DTL Financial Aid > Student
Loans Company > View
Remittance Staging Table >
View Remittance Staging
Table


View Remittance imported
data.


Viewing Remittance Imported Data
Access the View Remittance Staging Table page (Financial Aid > Student Loans Company > View
Remittance Staging Table > View Remittance Staging Table).


Image: View Remittance Staging Table page


This example illustrates the fields and controls on the View Remittance Staging Table page. You can find
definitions for the fields and controls later on this page.


Payment Date Displays the date that the funds are transferred to HEI.


Payment Type Displays the type of funds being transferred:


• T: Loan


• G: Grant
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This field is blank if the information was not provided in the
Remittance Report file.


Total Fee Amount Displays the total net amount of fees in this roster.


Record Count Displays the total number of records in this roster.


Remittance Report Information
Course Start Period Displays the period when the course starts, for example AUT 


(Autumn).


Course Code Displays the UCAS code that is assigned to the course.


Revision Indicator Indicates a change in entitlement since a previous ACR.


Fee Amount Displays the fee amount for the student.


Viewing SLC Student Data


This section discusses how to:


• View SSAR student data.


• View SSAR name and address data.


• View SSAC student data.


• View SSAC export data.


• View ACR and SISF data.


• View Attendance Confirmation by Liability Period.


• View HEBSS student data.


Pages Used to View Student Data
Page Name Definition Name Navigation Usage


SSAR SFA_SLC_SSAR Financial Aid > Student
Loans Company > View SLC
Student Data > SSAR


View SSAR data.


SLC SSAR Name and
Address


SFA_SLC_SSAR_SEC Click the Name/Address link
on the SSAR page.


View SSAR name and address
data.


SSAC SFA_SLC_SSAC Financial Aid > Student
Loans Company > View SLC
Student Data > SSAC


View SSAC student data.
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Page Name Definition Name Navigation Usage


View SSAC Export Data SFA_SLC_SSAC_DTL Financial Aid > Student
Loans Company > View
Exported SSAC Data


View SSAC export data.


ACR/SISF SFA_SLC_ACR Financial Aid > Student
Loans Company > View SLC
Student Data > ACR/SISF


View ACR and SISF student
data.


Attendance Confirmation SFA_SLC_ATD_CFR Financial Aid > Student
Loans Company > View SLC
Student Data > Attendance
Confirmation


View Attendance
Confirmation data for SLC
Liability Period.


HEBSS SFA_SLC_HEBSS Financial Aid > Student
Loans Company > View SLC
Student Data > HEBSS


View HEBSS student data.


SLC HEBSS Name and
Address


SFA_SLC_HEBSS_SEC Click the Name/Address link
on the HEBSS page.


View HEBSS name and
address data.


Viewing SSAR Student Data


Bundle 50


Added “Credit Value” field to Course Information group box.


Access the SSAR page (Financial Aid > Student Loans Company > View SLC Student Data > SSAR).


Image: SSAR page


This example illustrates the fields and controls on the SSAR page. You can find definitions for the fields
and controls later on this page.


Use this page to view the details of students' SSAR records. The page is view-only with the exception
of the Tuition Fee Loan Payable and Tuition Fee Grant Payable fields. These fields can be updated for
Scottish students whose SSNs begin with SAAS.


Physical Attendance Confirmed Select this check box to indicate that a student's physical
attendance on the campus has been confirmed. This check box


Copyright © 2018, Oracle and/or its affiliates. All rights reserved. 27







(GBR) Using Student Loans Company Chapter _


can be selected on this page or set by the institution's custom
process.


SSAR Information
Issue Date Displays the issue date of the SSAR.


Sequence Displays the internal sequence number used to indicate the
version of the individual student's SSAR file.


SSAR File Seq (Student Support
Attendance Requests file sequence
number)


Displays the sequence number, which is unique within the SLC
for the HEI, academic year, and file type.


Fee Support
Tuition Fee Loan Payable Displays the portion of the fee paid by TFL.


Note: You can update this field for Scottish students whose
SSNs begin with SAAS.


Tuition Fee Grant Payable Displays the portion of the fee paid by the TFG.


Note: You can update this field for Scottish students whose
SSNs begin with SAAS.


Loan Applied For Displays the type of loan for which the student applied. Values
are:


• F (Full Entitlement)


• P (Part Entitlement)


• N (No loan applied for)


Viewing SSAR Name and Address Data
Access the SLC SSAR Name and Address page (click the Name/Address link on the SSAR page).
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Image: SLC SSAR Name and Address page


This example illustrates the fields and controls on the SLC SSAR Name and Address page.


Use this page to help determine whether you are matching to the correct person.


Viewing SSAC Student Data
Access the SSAC page (Financial Aid > Student Loans Company > View SLC Student Data > SSAC
tab).
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Image: SSAC page


This example illustrates the fields and controls on the SSAC page. You can find definitions for the fields
and controls later on this page.


You can view the details of SSAC data for students on this page. This page is view-only with the
exception of the SLC Course Code and Year of Course fields. These fields can be updated after the SSAC
data is populated but before exporting the data. After the SSAC data is exported, these fields are also
view-only.


Physical Attendance Confirmed Select this check box to indicate that a student's physical
attendance on the campus has been confirmed. This check box
can be selected on this page or set by the institution's custom
process.


SSAC Information
Processing Status A status of Processed indicates that the SSAC data has been


exported to a file.


A status of Unprocessed indicates that the SSAC data has not
been exported to a file.


Attendance Confirmed Date Displays the date that the Physical Attendance Confirmed check
box was selected for the student.


Location Code Displays a two-digit location code representing a specific
location at the HEI. The default value is 01 and the range is 01
to 99.


File Sequence Nbr (file sequence
number)


Displays an internal sequence number.
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Viewing SSAC Export Data
Access the View Exported SSAC Data page (Financial Aid > Student Loans Company > View Exported
SSAC Data).


Image: View Exported SSAC Data page


This example illustrates the fields and controls on the View Exported SSAC Data page. You can find
definitions for the fields and controls later on this page.


Use this page to view the details of the students' exported SSAC data.


Attendance Confirmed Date Displays the date that the Physical Attendance Confirmed check
box was selected for the student.


Viewing ACR and SISF Student Data


Bundle 50


Added “Credit Value” field to Extended SISF Information group box.


Access the ACR/SISF page (Financial Aid > Student Loans Company > View SLC Student Data >
ACR/SISF tab).
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Image: ACR/SISF page (1 of 2)


This example illustrates the fields and controls on the ACR/SISF page 1 of 2). You can find definitions
for the fields and controls later on this page.


Image: ACR/SISF page (2 of 2)


This example illustrates the fields and controls on the ACR/SISF page 2 of 2). You can find definitions
for the fields and controls later on this page.


Use this page to view the details of ACR or SISF data for students.


All fields on this page, except for the Attendance Indicator field, are view-only.


ACR/SISF Information
Issue Date Displays the date that the ACR/SISF was issued.
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Attendance Indicator This field appears only if the value in the File Type field is
Attendance Confirmation Reqst.


The field contains a list of At Fee Code values that can be
manually set on this page. You can manually set this field
instead of running the Evaluate ACR process.


File Type Displays the file type: Attendance Confirmation Reqst, Student
Information Service, or Extended SISF.


If the value is Extended SISF, the Extended SISF Information
group box appears.


Student Status Date Displays the date that the student's status was assigned or
updated.


Course/Fee Information
Course Start Period Displays the period when the course starts, for example AUT 


(Autumn).


New Record Indicates whether the record appeared on a previous ACR.


Course Code Displays the UCAS code or SLC code that is assigned to the
course.


Note: For this field, and the remaining fields in this group box,
 values appear in both the SLC Values and Calculated Values
columns.
The values in the SLC Values column come from the context
ACR or SISF record.
The values in the Calculated Values column appear after the
ACR At Fee Evaluation process is run.


Other Information
Revision Indicator Indicates whether the record has changed since a previous ACR/


SISF.


FTE Details
Override FTE Enter a value here and save to override the Calculated FTE.


Report Zero Select this check box to report FTE of zero.


Note: Once you have overridden a student's FTE or selected Report Zero for a student's FTE for a
Liability Period then that overridden or zero value remains until manually removed, even if the Calculate
FTE process is rerun.
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Academic Load Details
Academic Load Displays the student's Academic Load from the ACR.


Override Value Enter a value here and save to override the student's Academic
Load.


Viewing Attendance Confirmation Data by Liability Period
Access the Attendance Confirmation page (Financial Aid >Student Loans Company >View SLC Student
Data >Attendance Confirmation tab).


Image: Attendance Confirmation page


This example illustrates the fields and controls on the Attendance Confirmation page. You can find
definitions for the fields and controls later on this page.


You can use this page to view details of attendance confirmation file information sent for the three
SLC Liability Periods. There is a group box for each of the Liability Periods: Attendance Reporting 1,
Attendance Reporting 2, and Attendance Reporting 3.


Viewing HEBSS Student Data
Access the HEBSS page (Financial Aid > Student Loans Company > View SLC Student Data > HEBSS
tab).
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Image: HEBSS page (1 of 2)


This example illustrates the fields and controls on the HEBBS page. You can find definitions for the fields
and controls later on this page.


Image: HEBSS page (2 of 2)


This example illustrates the fields and controls on the HEBSS page (2 of 2). You can find definitions for
the fields and controls later on this page.


You can view the details of the student's HEBSS data on this page. This page is view-only.


Note: For information about the fields in the Application/Award Information group box, refer to the
information about the group box in the Manage HEBSS Suspensions section.
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HEBSS Information
Assessment Date Displays the date the customer record was entered or updated on


the Higher Education (HE) portal.


File Name Displays the data file name from SLC.


Course Information
Qualification Displays the qualification achieved.


Method of Attendance Displays the method of attendance. Values are:


• Full Time


• Part Time


• PGCE  (post graduate)


Viewing HEBSS Name and Address Data
Access the SLC HEBSS Name and Address page (click the Name/Address link on the HEBSS page).


Image: SLC HEBSS Name and Address page


This example illustrates the fields and controls on the SLC HEBSS Name and Address page.


Use this page to help determine whether you are matching to the correct person.
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Reconciling Tuition Fee Payments


This section provides an overview of reconciling Tuition Fee payments to HEI's from the SLC and
discusses how to:


• View the Remittance Report File Summary.


• View Remittance Data to Student Award Data Comparison.


• View Student Award Details.


• View FA Disbursement Data to SF Item Data Comparison.


• View FA/SF Details.


Understanding Tuition Fee Payments Reconciliation
You can configure the system to use SLC Tuition Fee Loan and Tuition Fee Grant payment data to pay
students' tuition fees. HEI's can use the system to reconcile actual payments received from the SLC,
represented by Remittance Report file data, with payments that have been made to students.


Pages Used to Reconcile Tuition Fee Payments
Page Name Definition Name Navigation Usage


Remittance Report File
Summary


SFA_SLC_TFRA_SUMRY Financial Aid > Student
Loans Company >
Remittance Report File
Summary > Remittance
Report File Summary


View the Remittance Report
files that have been loaded for
a HEI/SLC academic year.


Remittance Reconciliation SFA_SLC_TFRA_RECON Financial Aid > Student
Loans Company >
Remittance Reconciliation >
Remittance Reconciliation


View a comparison of
Remittance data and Student
Award Data for an Institution/
Aid Year/HEI, which maps to
the HEI/SLC academic year.


Remittance /Student Awards SFA_SLC_TFRA_AWARD Financial Aid > Student
Loans Company >
Remittance Reconciliation >
Remittance/Student Awards


View the details for student
remittance and award data.


Disbursement Reconciliation SFA_DISB_SF_RECON Financial Aid >
Student Loans >
Company > Disbursement
Reconciliation >
Disbursement Reconciliation


View a comparison of FA
Disbursement data and SF
Item data.


FA/SF Details SFA_DISB_SF_RECON1 Financial Aid > Student
Loans Company >
Disbursement
Reconciliation > FA/SF
Details


View the details for student
Financial Aid Disbursement
data and Student Financials
Item data.
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Viewing the Remittance Report File Summary
Access the Remittance Report File Summary page (Financial Aid > Student Loans Company >
Remittance Report File Summary).


Image: Remittance Report File Summary page


This example illustrates the fields on the Remittance Report File Summary page.


Use this page to learn which files have been loaded for the current HEI and SLC academic year.


Viewing the Remittance Data to Student Award Data Comparison
Access the Remittance Reconciliation page (Financial Aid > Student Loans Company > Remittance
Reconciliation).


Image: Remittance Reconciliation page


This example illustrates the fields and controls on the Remittance Reconciliation page. You can find
definitions for the fields and controls later on this page.


Use this page to compare Remittance data to Student Award Data for a particular institution, aid year, and
HEI combination.
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Remittance Report and Award Grand Totals
This group box lists the totals by payment type, such as grant or tuition. The page uses the values in
the Remittance Report Parameters group box on the Student Loans Company Setup - Options page to
associate item type groups with payment types.


Filter Option
Use the Filter Option group box to filter results by Payment Type, Student Support Number, or ID. Click
the Search button to access the Remittance /Student Awards page.


Viewing Student Award Details
Access the Remittance/Student Awards page (Financial Aid > Student Loans Company > Remittance
Reconciliation > Remittance/Student Awards).
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Image: Remittance/Student Awards page


This example illustrates the fields and controls on the Remittance/Student Awards page. You can find
definitions for the fields and controls later on this page.


Remittance Report Records with no Student ID or Awards
This group box lists Remittance Report data that is not associated with a student ID or does not have a
matching SLC Financial Aid Award. For example, a Remittance Report record was received but could not
be matched with a student in the system. Or a Remittance Report record with a Student Support Number
is matched to a student ID, but that student does not have any SLC Financial Aid Awards. You can view
details about the Remittance Report records in this group box by clicking on the Student Information,
Course Information, and Other Information tabs.
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Student Awards with no Remittance Report Data
This group box lists students who have SLC Financial Aid awards that do not have matching Remittance
Report data.


Remittance Report and Award Data Comparison
This group box lists students who have Remittance Report data and SLC Financial Aid award data and
displays differences, if any, between the two.


Viewing the FA Disbursement Data to SF Item Data Comparison
Access the Disbursement Reconciliation page ((Financial Aid > Student Loans Company >
Disbursement Reconciliation).


Image: Disbursement Reconciliation page


This example illustrates the fields and controls on the Disbursement Reconciliation page. You can find
definitions for the fields and controls later on this page.


Use this page to compare Financial Aid disbursement data to Student Financials item data.


Filter Option
Use the Filter Option group box to filter results by Item Type Group, Financial Aid Item Type, or ID.
Press the Search button to access the FA/SF Details page.


Note: You can use this page to access information about any Financial Aid Item Types. It is not limited to
SLC Item Types.
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Viewing FA/SF Details
Access the FA/SF Details page (Financial Aid >Student Loans Company >Disbursement
Reconciliation >click Search).


Image: FA/SF Details page


This example illustrates the fields and controls on the FA/SF Details page.


Use this page to view disbursement details.


Updating HEI Course Database Data


This section provides an overview of the HEI Course Database and discusses how to exchange HEI
Course Database data.


Understanding the HEI Course Database
HEIs in the United Kingdom report information on all their courses of study (programmes) to the SLC.
This data must be updated annually.


The course data is general, such as costs or descriptions of courses of study, and is not specific to the
student. The SLC uses this course data when processing students' applications for support.


The SLC provides an XML-based web service to exchange this information with HEIs. The SLC provides
the current HEI Course Database data to the HEI, and the HEI must provide the SLC with updated
information.


The SLC requests the HEI Course Database updates from HEIs each academic year.
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Page Used to Exchange HEI Course Database Data
Page Name Definition Name Navigation Usage


Exchange HEI Course
Database Data


SFA_SLC_RC_CD Financial Aid > Student
Loans Company > HEI
Course Database > Exchange
HEI Course DB Data >
Exchange HEI Course
Database Data


Exchange HEI Course
Database data.


Exchanging HEI Course Database Data
Access the Exchange HEI Course Database Data page (Financial Aid > Student Loans Company > HEI
Course Database > Exchange HEI Course DB Data > Exchange HEI Course Database Data).


Image: Exchange HEI Course Database Data page


This example illustrates the fields and controls on the Exchange HEI Course Database Data page. You can
find definitions for the fields and controls later on this page.


Course Database Parameters
HEI Code (higher education institution
code)


Select a value in this mandatory field.


The prompt view restricts the values from which you can select
to those found in the Student Loans Company Setup component.


SLC Acad Year (Student Loans
Company academic year)


Select a value in this mandatory field.


The prompt view restricts the values from which you can select
to those found in the Student Loans Company Setup component.


Action Select a web service action from the following:


• Download Course Catalog:


Select to use the web service to retrieve HEI Course
Database data for the designated HEI code and SLC
academic year and store the data in system tables.
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You can then update data in the Maintain HEI Institution
Data (SFA_SLC_CD_INST), Maintain HEI Location Data 
(SFA_SLC_CD_LOC), and Maintain HEI Course Data 
(SFA_SLC_CD_CRSE) components.


Selecting this action retrieves Qualification values (the
Fetch Qualifications action) as well as downloading course
catalog data.


Note: Download Course Catalog should be the first action
taken in the HEI Course Database process.


• Fetch Qualifications:


Select to use the web service to retrieve only the valid
values that can be used to update the Qualifications field
on the Maintain HEI Courses page. Select this action if the
Qualifications list of values needs to be updated after the
initial Download Course Catalog completes.


• Submit Data Changes:  Select to use the web service to
send updates for any changed Location, Institution, Year, or
Course data.


Maintaining HEI Data


This section provides an overview of HEI data and discusses how to:


• View and update HEI institution data.


• View and update HEI location data.


• View and update HEI course data.


Understanding HEI Data
Use the Maintain HEI Institution Data, Maintain HEI Locations, and Maintain HEI Courses components
to:


• Retrieve HEI Course Database data from the SLC using the web service.


• Maintain HEI Course Database data.


• Send HEI Course Database data updates to the SLC.


Common Elements Used in this Section
Get SLC Data Click this button to retrieve the latest information from the SLC.
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Send to SLC To send updated data to the SLC, add a row, update the relevant
editable fields, and click the Send to SLC button.


When the SLC receives updated information, it sends a result
number and result message.


Result Number Displays the result code number that the SLC sends to the HEI
when it receives updated information from the HEI.


Result Message Displays an explanation of the result reply from the SLC.


Pages Used to View and Update HEI Data
Page Name Definition Name Navigation Usage


Maintain HEI Institution Data SFA_SLC_CD_INST Financial Aid > Student
Loans Company > HEI
Course Database > Maintain
HEI Institution Data >
Maintain HEI Institution Data


View and update HEI
institution data.


Maintain HEI Locations SFA_SLC_CD_LOC Financial Aid > Student
Loans Company > HEI
Course Database > Maintain
HEI Locations > Maintain
HEI Locations


View and update HEI location
data.


Maintain HEI Courses SFA_SLC_CD_CRSE Financial Aid > Student
Loans Company > HEI
Course Database > Maintain
HEI Courses > Maintain HEI
Courses


View and update HEI course
data.


Viewing and Updating HEI Institution Data
Access the Maintain HEI Institution Data page (Financial Aid > Student Loans Company > HEI Course
Database > Maintain HEI Institution Data > Maintain HEI Institution Data).
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Image: Maintain HEI Institution Data page


This example illustrates the fields and controls on the Maintain HEI Institution Data page. You can find
definitions for the fields and controls later on this page.


Institution Year Information
Fee Cap Enter the Office for Fair Access cap for fees.


Predicted Courses Enter the predicted number of courses offered by the institution.


Variable Fees Select to indicate that the institution offers variable fees.


Last Updated Displays the date and time that this record was last updated.


Institution Details
HEI Name, Country Code, and UCAS
College Code


Enter the institution name, country code, and UCAS college
code.


Live Date Displays the date that the Course became available for selection
in the live portal.
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Viewing and Updating HEI Location Data
Access the Maintain HEI Locations page (Financial Aid > Student Loans Company > HEI Course
Database > Maintain HEI Locations > Maintain HEI Locations).


Image: Maintain HEI Locations page


This example illustrates the fields and controls on the Maintain HEI Locations page. You can find
definitions for the fields and controls later on this page.


Location Details
Active Select to indicate that the location is active.


Primary Location Select to indicate that the location is a primary location for the
institution.


Viewing and Updating HEI Course Data
Access the Maintain HEI Courses page (Financial Aid > Student Loans Company > HEI Course
Database > Maintain HEI Courses > Maintain HEI Courses).
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Image: Maintain HEI Courses page


This example illustrates the fields and controls on the Maintain HEI Courses page. You can find
definitions for the fields and controls later on this page.


Course Information
SLC Course Code (Student Loans
Company course code)


The value in this field is assigned by the SLC. The value is
blank when a HEI sends information about a new course to the
SLC.


Method of Attendance Enter a method of attendance. Values are:


• FE (Full Time and Extended Attendance)


• FP (Full Time and Part Time Attendance)


• FS (Full Time Plus Sandwich Attendance)


• FT (Full Time Attendance)


• OT (Unknown Method of Attendance)
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• PT (Part Time Attendance)


UCAS Suffix Displays the campus code/location.


Course Type Enter a course type. Values are:


• ACCELERATED (Course compresses a two year course into
one year of study)


• ART TEACHER


• EMERGENCY


• FRANCHISED


• OTHER


• PART TIME


• PGCE (Post Graduate Certificate In Education)


Course Status Enter a course status. Values are:


• C (Closed)


• O (Open)


Qualification Select from a list of values that appear by default from the SLC
web service. The value indicates the type of degree to which the
course leads.


UCAS Course Select this check box if the course is a UCAS course.


Year and Term Details
Fee Cap Enter the maximum tuition fees to be charged for the designated


year of the course.


Term Number Enter the term number within the year of the course.


Campus Code Enter the campus code that applies to the term for which you
entered a number in the Term Number field.


Start Date and End Date Enter the start date and end dates for the term for which you
entered a number in the Term Number field.


Other Codes
Code Type Enter a code type. Values are:


• ucas


• jacs


• ucasSuffix
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Mapping
Academic Career Enter the Academic Career to map to the Course.
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CS Updates and Changes for Bundle #50, Regulatory Release 1 2019-2020 


Copyright © 2018, Oracle. All rights reserved. 


The Programs (which include both the software and documentation) contain proprietary information; they are 
provided under a license agreement containing restrictions on use and disclosure and are also protected by 
copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or 
decompilation of the Programs, except to the extent required to obtain interoperability with other 
independently created software or as specified by law, is prohibited. 


The information contained in this document is subject to change without notice. If you find any problems in 
the documentation, please report them to us in writing. This document is not warranted to be error-free. 
Except as may be expressly permitted in your license agreement for these Programs, no part of these 
Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any 
purpose. 


If the Programs are delivered to the United States Government or anyone licensing or using the Programs 
on behalf of the United States Government, the following notice is applicable: 


U.S. GOVERNMENT RIGHTS  
Programs, software, databases, and related documentation and technical data delivered to U.S. 
Government customers are “commercial computer software” or “commercial technical data” pursuant to the 
applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, 
duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical 
data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, 
to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--
Restricted Rights (June 1987). Oracle Corporation, 500 Oracle Parkway, Redwood City, CA 94065. 


The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently 
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, 
redundancy and other measures to ensure the safe use of such applications if the Programs are used for 
such purposes, and we disclaim liability for any damages caused by such use of the Programs. 


The Programs may provide links to Web sites and access to content, products, and services from third 
parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. 
You bear all risks associated with the use of such content. If you choose to purchase any products or 
services from a third party, the relationship is directly between you and the third party. Oracle is not 
responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the 
agreement with the third party, including delivery of products or services and warranty obligations related to 
purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may 
incur from dealing with any third party. 


Oracle, JD Edwards, and PeopleSoft are registered trademarks of Oracle Corporation and/or its affiliates. 
Other names may be trademarks of their respective owners. 


Open Source Disclosure 


Oracle takes no responsibility for its use or distribution of any open source or shareware software or 
documentation and disclaims any and all liability or damages resulting from use of said software or 
documentation. The following open source software may be used in Oracle’s PeopleSoft products and the 
following disclaimers are provided. 


Apache Software Foundation 


This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/). Copyright 1999-2000. The Apache Software Foundation. All rights reserved.  
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THIS SOFTWARE IS PROVIDED “AS IS'” AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE 
SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 


OpenSSL 


Copyright 1998-2003 The OpenSSL Project. All rights reserved.  


This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit 
(http://www.openssl.org/). 


THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, 
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE. 


SSLeay 


Copyright (C) 1995-1998 Eric Young. All rights reserved. 


This product includes cryptographic software written by Eric Young  (eay@cryptsoft.com). This product 
includes software written by Tim Hudson (tjh@cryptsoft.com). Copyright (C) 1995-1998 Eric Young. All 
rights reserved. THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 


Loki Library 


Copyright 2001 by Andrei Alexandrescu. This code accompanies the book: Alexandrescu, Andrei. 
“Modern C++ Design: Generic Programming and Design Patterns Applied”. Copyright (c) 2001. 
Addison-Wesley. Permission to use, copy, modify, distribute and sell this software for any purpose is 
hereby granted without fee, provided that the above copyright notice appear in all copies and that both 
that copyright notice and this permission notice appear in supporting documentation 
 


Helma Project 
 



mailto:tjh@cryptsoft.com
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Copyright 1999-2004 Helma Project. All rights reserved. THIS SOFTWARE IS PROVIDED “AS IS” AND 
ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE HELMA PROJECT OR ITS CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 


 
Helma includes third party software released under different specific license terms. See the licenses 
directory in the Helma distribution for a list of these license. 


 
Sarissa 
 


Copyright 2004 Manos Batsis 
 


This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser 
General Public License as published by the Free Software Foundation; either version 2.1 of the 
License, or (at your option) any later version. 


 
This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without 
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See 
the GNU Lesser General Public License for more details. 


 
You should have received a copy of the GNU Lesser General Public License along with this library; if 
not, write to the Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA  02111-1307 
USA. 
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Updates for CS 9.0 Bundle #50, Regulatory 
Release 1 2019-2020 
Note. This PDF package is an update to the PeopleSoft Financial Aid 9.2 PeopleBook and other 
related Campus Solutions PeopleBooks as noted. It describes CS 9.0 Patch ID #27978028/ 
Product Update ID #942961 that was posted to My Oracle Support in July 2018. Use this PDF 
package in conjunction with your PeopleBook to maintain a complete set of documentation. 


Documentation about bundle changes is incorporated into the relevant 9.2 PeopleBook chapters. 


PDFs of the updated 9.2 chapters that contain the 9.0 bundle changes are attached. 


Use this Overview document to view a list of the bundle changes and updated chapters. 


Using PDF Package (PDF Portfolio) Documentation 
These instructions are for Adobe Reader DC with the latest updates installed (In Adobe Reader, 
click Help, Check for Updates).  
To view the list of chapters, click View > Portfolio > Details. 
To search for documentation about the changes within a particular chapter, open the chapter and 
press CTRL + F. Enter “bundle xx” where xx is the bundle number and click Next. 
To search the entire package for documentation updates, click Edit > Search Entire Portfolio. 


 
Note! Cross references in PDF chapters appear as follows: 
  
• If a cross reference is to a topic in the same book (for example, Campus Community topic A 


contains a cross reference to Campus Community topic B), the cross reference displays only 
the topic title.  


 
• If a cross reference is to a topic in a different book, the cross reference displays the topic title 


and the book name.  
 
• Some cross references appear as links but are actually text-only.  
 


Here is a list of the Bundle 50 changes and the chapters that contain documentation about those 
changes. Chapters are in the PeopleSoft Financial Aid 9.2 PeopleBook unless noted otherwise: 


• Updated PROFILE for 2019-2020 Aid Year. 
 
o Processing and Using Institutional Financial Aid Applications.pdf 


 


• Updated Return to Title IV Worksheet. 
  


o Processing Return of Title IV Funds.pdf 
 


• Updated Student Loans Company (GBR). 
  


o Using Student Loans Company.pdf 
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Updates Not in Documentation 
These updates did not require updates to PeopleBooks or Online Help: 


 


• UPDATE ADDITIONAL ELIGIBILITY INDICATOR BASED ON % OF SCHEDULED PELL USED – Critical 
Patch 27677220 originally released on June 11, 2018. 


• 2018 - 2019 AID YEAR UPDATES FOR FISAP REPORTING – Critical Patch 27614803 originally released 
on June 25, 2018. 
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Chapter _


Processing Return of Title IV Funds


Common Elements Used in Processing Return of Title IV Funds


 Date of Withdrawal Indicates one of the following: the last date of recorded
attendance, the date the student began the withdrawal process,
 the date the student provided your school with the intent to
withdraw, or the midpoint of the payment period if the student
unofficially withdraws. The system displays the default date
based on the date that was established in Campus Solutions
Student Records.


 Undetermined Withdrawal Date Select for students who have withdrawn unofficially. The
system displays the midpoint of the payment period in the
Date of Withdrawal field if the student unofficially withdraws.
 Update this field if you want to use a different withdrawal
date. For example, you can use the date when the student last
attended an academic-related event if this date was verified by
your institution.


 Institutional Determination Dt 
(institutional determination date)


Indicates the withdrawal date determined by the financial aid
office.


 ID Indicates the unique identification code for the student.


 Name Displays the name of the student.


 Days Elapsed After an institution determines the date of withdrawal, the
system displays the number of days passed since the student
withdrew.


Managing Data to Calculate Return of Title IV Aid


This section discusses how to manage data to calculate the return of Title IV aid.


Pages Used to Manage Data to Calculate Return of Title IV Aid
Page Name Definition Name Navigation Usage


Return TIV Session STDNT_RT_TIV_AID_M Financial Aid > Return
to TIV Funds > Return
TIV Session > Return TIV
Session


Manage return of Title IV aid
enrollment session data.
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Page Name Definition Name Navigation Usage


Return TIV Session Notes SFA_RTN_SES_NOTES Financial Aid >Return
to TIV Funds >Return
TIV Session >Return TIV
Session >Return TIV Session
Notes


Use this page to add
notes about the student's
withdrawal.


Return TIV Aid STDNT_RTRN_TIV_AID Financial Aid > Return
to TIV Funds > Create
Worksheet > Return TIV Aid
Funds Worksheet > Return
TIV Aid


Manage the return of Title
IV aid. Add a student who
has withdrawn, calculate the
withdrawal percentage, view
various dates from different
sources, view the payment or
enrollment period, or view
term information.


Packaging Status Summary STDNT_AID_PACKAGE Click the Student Status  link
on the Return TIV Aid page.


Review the student's need,
 budget, and award or
to change the student's
packaging status.


FA Term STDNT_FA_TERM Click the FA Term link on the
Return TIV Aid page.


View a student's term
information, add a new term
for a student, or build the
student's financial aid term.


Last Updated STDNT_RTRN_TIVSEC5 Click the Last Updated link
on the Return TIV Aid page.


View the user's ID and the
date and time of the last
update made to the Return
Title IV Aid page.


Managing Return of Title IV Aid Enrollment Session Data
Access the Return TIV Session page (Financial Aid > Return to TIV Funds > Return TIV Session >
Return TIV Session).
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Image: Return TIV Session page


This example illustrates the fields and controls on the Return TIV Session page. You can find definitions
for the fields and controls later on this page.


On the initial add, this page is populated with data from the Term Session table and Student Records.
This data can be adjusted for the first and subsequent withdrawals based on student changes and/or your
school's business process.


Calculate All Click to populate the Period Summary information with the
student's calculated withdrawal information for days and percent
earned.


Last Updated Click to access the Last Updated page to view the user ID, last
update timestamp, and other information for the last update
made to the page.


Session Details
Session Enter the Session from the Term in context to populate the


Session Begin Date, Session End Date, and Holiday Schedule
fields.


Session Break Displays number of days in Session Break. Session Breaks
greater than 4 days are deducted from total number of calendar
days and completed calendar days, if withdrawal occurs after
the Break. Sessions must be entered in order by start date, then
end date.


Student enrollment in non-unique Sessions may warrant
grouping of Sessions in order to calculate the percent of aid
earned. Sessions that overlap display as a negative number of
days to show that those days are offset in the calculation.
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Note: Completed Days and Total Days are gross days for the
Session Period; deductions for Holiday or Session Break are not
accounted for in this group box.


Status Select the status for the Session.


• Cancel – This status cannot be manually selected but is
populated from Term History Session Withdraw.


• Completed – Student has completed all classes for the
Session.


• In Progress – Student is actively attending classes for the
Session.


• Not Enrolled – Student not enrolled in any classes for the
Session.


• Not Started – Session has not started.


• Rescind – Student previously qualified for and had a RTIV
calculation processed. Due to re-enrollment or proof of
intent to enroll in a future session, the withdraw has been
rescinded.


• Withdraw – Populated from Term History Session Withdraw.
 Can be manually selected.


Completed Days Displays number of days completed in the Session.


Note: Completed Days and Total Days are gross days;
deductions for Holiday or Session Break are not accounted for
in this group box.


Total Days Displays total number of days in the Session.


Note: Completed Days and Total Days are gross days;
deductions for Holiday or Session Break are not accounted for
in this group box.


Period Summary
Period Summary is populated from calculated Session Detail information. It summarizes the dates, days,
and percent earned to be used in Create Worksheet to complete the withdrawal calculation process.


Completed Days for Period Displays calculated earned days.


Note: Holiday and/or Session breaks of 5 days or more are
deducted from Completed days based on withdrawal date and
passage of break period.


Completed Days for Period Override Select to override calculated completed days.
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Total Days for Period Displays calculated total days for entire span of sessions as
determined by the institution.


Note: Holiday and/or Session breaks of 5 days or more are
deducted from Total Days.


Total Days for Period Override Select to override calculated total days.


Period Adjustment Displays the adjustment that is required for scheduled holidays
of five consecutive days or more. The system displays 0 if no
holidays are scheduled consecutively for 5 or more days.


Total Session Break Displays the total of all breaks between sessions greater than 4
days.


Period Adjustment Override Select to override the Period Adjustment .


Holiday Schedule and Detail Displays the name of the Holiday Schedule. Click Detail link for
detailed Holiday Schedule information.


Pct. TIV Aid Earned for
Period(Percent Title IV aid earned for
period)


Displays calculated percent of aid earned.


Date of Withdrawal Displays highest date of withdrawal from Session Details.


Session Period Begin Date Displays lowest session begin date based on session rows
inserted in Session Details.


Session Period End Date Displays highest session begin date based on session rows
inserted in Session Details.


60 Pct Eff Dt for Session(60 percent
effective date for session)


Displays the 60 percent date for the Session Period Begin and
Session Period End dates.


Return TIV Session Notes
Access the Return TIV Session page (Financial Aid > Return to TIV Funds > Return TIV Session >
Return TIV Session > Return TIV Session Notes tab).


Use this page to add notes about the student's withdrawal.


Managing the Return of Title IV Aid
Access the Return TIV Aid page (Financial Aid > Return to TIV Funds > Create Worksheet > Return
TIV Aid Funds Worksheet > Return TIV Aid).
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Image: Return TIV Aid page


This example illustrates the fields and controls on the Return TIV Aid page. You can find definitions for
the fields and controls later on this page.


The fields are populated with data generated by the Return to TIV Session component.


 Student Status Click to access the Packaging Status Summary page to review
the student's need, budget, and award or to change the student's
packaging status.


 FA Term Click to access the Financial Aid Term page to view a student's
term information, add a new term for a student, or build the
student's financial aid term. If the student withdraws and the
withdrawal date defined by Student Records changes, you must
rebuild the FA Term.


 Calculate All Click to update and populate the fields with the student's
calculated withdrawal information. The system displays the
withdrawal status of the student for the specified term or
sessions within a term and calculates the actual values for the
amount of earned aid, amount of unearned aid, and amount of
aid to be returned. When you click this link, the system uses the
setup and award data specific to the student. If you change the
start and end dates from the Return TIV Aid page or Return TIV
Session page, click the Calculate All button to update the values
on the Return of Funds Worksheet page.


Summary
 Days Elapsed After an institution determines the date of withdrawal, the


system calculates and displays the number of days passed
since the student withdrew. The days are calculated using the
Institutional Determination Date field as a starting date.


 Overall Status Select the student's withdrawal status. The values are:
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Pending: The calculation and the return of Title IV funds
are still in progress. The default status is Pending until you
manually change the status to Complete.


Complete: Indicates that the calculation, the student notification,
 and the return of Title IV funds has occurred. After you set the
status to Complete, affected fields and pages become view-only.


 Date Form Completed Displays the date when the Calculate All button is clicked on
this page to calculate the student's withdrawal percentage. The
date is set to the current date by default when you change the
overall status to Complete. The Oprid is also updated when you
change the status to Complete and save. You can view the Oprid
updates on the RTIV Calculation History page when you click
the Last Updated link.


 FA Term Academic Career Displays the grouping of all academic work undertaken by a
student at an institution. This information is from the Financial
Aid Term table.


 Last Updated Click this link to access the RTIV Calculation History page and
view the Oprid, last update timestamp, and other information for
each time the Overall Status has been updated to Complete and
saved on this page.


Access the RTIV Calculation History page (Financial Aid >
Return to TIV Funds > Create Worksheet > Return TIV Aid
Funds Worksheet > Return TIV Aid > click the Last Updated
link).


Period Information
 Payment Period Select to indicate nonstandard periods or terms. A nonstandard


period or term is defined as a term that is not a quarter,
 semester, or trimester. It can be a payment period or a period
of enrollment. A payment period can consist of more than one
term.


 Enrollment Period Select to indicate the academic period determined by an
institution for which charges are assessed. The enrollment
period is the length of the term.


 Start Date and End Date Displays the beginning and ending date of the payment or
enrollment period. The system uses the start and end date in the
actual Return of Title IV Funds calculation for term processing.


Note: Because you can change the enrollment period start and
end dates that are used by the system to calculate the Title IV
percentage, you should establish procedures to define how these
dates should be changed.
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Term Information
 Term Displays the identification number for the term. A term is a


period of time designated as an instructional accounting period.


 Withdraw Date Displays the date the student withdrew from the term. The value
is from the Student Records Student Career Term table.


 60 Pct Dt  (60 percent date) Displays the default value from the Term Session table. This
is the date when a student would have completed 60% of the
credit/clock hour of the program for the term.


 Term Begin Date Displays the beginning date of the term.


 Term End Date Displays the ending date of the term.


 FA Term Withdraw Date Displays the date the student withdrew from the term. The
Financial Aid Term table provides the FA term withdrawal date.
 Student Records determines the date.


Session Information
 Session Displays the session from which the student has withdrawn.


 Withdraw Date Displays the date the student withdrew from the Session Period.
 The value is from the Student Records Student Career Term
table.


 Session Withdraw Date Displays the date the student withdrew from the Session Period
from the Return TIV Session Table.


 60 Pct Dt  (60 percent date) Displays the default value from the Term Session table. This is
the date when a student would have completed 60% of a single
session.


 60 Pct Effective Dt (60 percent
effective date)


Displays the 60 percent date for the Session Period Begin and
Session Period End dates.


 Session Period Begin Date Displays the lowest beginning date of the Session Period as
entered in the Return TIV Session table.


 Session Period End Date Displays the highest ending date of the Session Period as
entered in the Return TIV Session table.


Multiple Session Details Click this link to access the Return TIV Session component.
 This link displays only for Session records and is not displayed
for regular Term withdraws.


Use Session Calculation Data Select to use session information for calculating a session
withdraw. Not selecting results in a term withdraw calculation.


Related Links
Reviewing Student Packaging Status by Date
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Viewing Withdrawal Information


Using the Return of Funds Worksheet


Bundle 50


Updated pages and system logic to exclude ACG/SMART grant awards.


This section discusses how to:


• Generate a valid calculation.


• Recalculate TIV aid information.


• Recalculate percentage of TIV aid earned using credit hours.


• View institutional and budget charges.


• Calculate return amounts.


• Review loan debts for withdrawn students.


Pages Used to Generate a Valid Calculation
Page Name Definition Name Navigation Usage


Return of Funds Worksheet STDNT_RTRN_TIV_WK1N Financial Aid > Return of
Title IV Funds > Create
Worksheet > Return of Funds
Worksheet


Enter values in the editable
fields to generate a valid
calculation or to recalculate
the totals due by the student
and school.


Calculate TIV Aid
Information


STDNT_RTRN_TIVSEC1 Click the Detail link to the
right of the E. Total TIV Aid
Disb field on the Return of
Funds Worksheet page.


Recalculate or view the E.
 Total TIV Aid Disb field.
 The information displayed
under Student's TIV Aid
Information is from the
Student Award Disbursement
table and is used to populate
the fields under Student's TIV
Aid Amounts.


Calculate Pct. TIV Aid
Earned


STDNT_RTRN_TIVSEC2 Click the Detail link to the
right of the H. Pct. TIV Aid
Earned field on the Return of
Funds Worksheet page.


Recalculate the Percentage of
Title IV Aid Earned field and
view the Holiday Adjustment
field.


Calculate Charge Information STDNT_RTRN_TIVSEC6 Click the Detail link to
the right of the L. Total
Institutional Chrgs (charges)
field on the Return of Funds
Worksheet page.


View institutional and budget
charges.
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Page Name Definition Name Navigation Usage


Calculate Return Amounts STDNT_RTRN_TIVSEC4 Click the Detail link to the
right of P. Total School Must
Return field on the Return of
Funds Worksheet page.


View amounts to returned by
the institution.


Return of Loan Funds STDNT_RTN_TIVSEC7N Click the Detail link for the
R. Student Loan Repayment
Amount field on the Return of
Funds Worksheet.


Enter debt totals for various
loan types for withdrawn
students to reviewing loan
debts.


Generating a Valid Calculation
Access the Return of Funds Worksheet page (Financial Aid > Return of Title IV Funds > Create
Worksheet > Return of Funds Worksheet).


Image: Return of Funds Worksheet page


This example illustrates the fields and controls on the Return of Funds Worksheet page. You can find
definitions for the fields and controls later on this page.


Use the Detail links to view or recalculate specific amounts.


Click Calculate to recalculate the values based on the adjustments you made to the percentages.


Click Calculate All to update and populate the fields with the student's calculated withdrawal information.
The system displays the withdrawal status of the student for the specified term and calculates the actual
values for the amount of earned aid, unearned aid, and aid to be returned. The system uses the setup and
award data specific to the student.


If you change the start and end dates from the Return of TIV Aid page, click Calculate All to update the
values on the Return of Funds Worksheet page.


 E. Total TIV Aid Disb (E. total Title
IV aid disbursed)


Displays Title IV Grant and Loan Programs amounts to be
disbursed for grants, amounts that could have been disbursed
for grants, net amounts disbursed for loans and net amounts that
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could have been disbursed for loans. Totals based on the actual
federal worksheet are also displayed.


 F. Total TIV Grant Aid (F. total Title
IV grant aid)


Displays grant aid disbursed and amount that could have been
disbursed.


 G. Total TIV Aid (G. total Title IV
aid)


Displays grant and loan aid disbursed and amount that could
have been disbursed.


 H. Pct. TIV Aid Earned (H. percent
Title IV aid earned)


Displays percentage of period of enrollment completed.


 I. TIV Aid Earned (I. Title IV aid
earned)


Displays aid earned by the student based on percentage of
enrollment period completed.


 J. TIV Aid to Disburse (J. Title IV aid
to disburse)


Displays amount of aid that could have been disbursed.


 K. TIV Aid to Return (K. Title IV aid
to return)


Displays amount aid to be returned.


 L. Total Institutional Chrgs (L. total
institutional charges)


Displays the value of the charges your institution set up in the
Institutional Charges setup page. Institutional costs are defined
as charges—the cost of attendance—a student must pay to the
institution directly. Whether you use the actual or budgeted
charges, the system displays the value for the institutional
charges you defined in your setup.


 M. Pct TIV Aid Unearned (M.
percent title IV aid unearned)


Displays the amount to be returned based on the percentage of
the unearned aid.


 N. Unearned Inst Charges (N.
unearned institutional charges)


Displays the amount of aid that must be returned for unearned
institutional charges. For example, tuition is an institutional
charge. If a student withdraws at 10% of the term, the student
earns 10% of the charges for tuition. The remaining 90% is
unearned.


 O. Amt Due From School (O. amount
due from school)


Displays the amount of aid the institution must return to the
Title IV program. The institution determines its share of
unearned funds first.


 P. Total School Must Return: Displays the total loans the school must return.


 Q. Amt Due From Student (Q.
amount due from student)


Displays the amount of aid the student must return to the Title
IV program. The student returns the difference between the Title
IV aid to be returned and the amount of Title IV aid due by the
institution. For example, if the returned aid is 1000.00 USD
and your institution returns 600.00 USD, the initial unearned
calculation for the student to return is 400.00 USD.


 R. Stdnt Loan Repaymnt Amt: (R.
Student loan repayment amount)


Displays the total amount the student must repay, which consists
of loan funds the student has earned, or unearned loan funds that
the school is not responsible for repaying, or both.
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 S. Initial TIV Grant Amount: (S.
initial Title IV grant amount)


Displays the Initial amount of Title IV grants the student must
return.


 T. TIV Grant Protection Amt: (T.
Title IV grant protection amount)


Displays the amount of Title IV grant protected using the value
in F. Total TIV Grant Aid and applying the 50 percent grant
protection.


 U. TIV Grant Return Amt: (U. Title
IV grant return amount)


Displays the net Title IV grant funds that the student must
return.


Action After you calculate the Return of Title IV Funds, the system
displays a note as a reminder to update the tracking fields
on the Student/School Return page or the Post-Withdrawal
Disbursement page based on what has occurred with the student.


Recalculating TIV Aid Information


Bundle 50


New screen shot.


Access the Calculate TIV Aid Information page (click the Detail link to the right of the E. Total TIV Aid
Disb field on the Return of Funds Worksheet page).


Image: Calculate TIV Aid Information page


This example illustrates the fields and controls on the Calculate TIV Aid Information page. You can find
definitions for the fields and controls later on this page.


The system displays grant and net loan amounts that are disbursed and that could have been disbursed.
Totals based on the actual federal worksheet are also displayed
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Recalculating Percentage of TIV Aid Earned Using Credit Hours


Bundle 50


New screen shot.


Access the Calculate Pct. TIV Aid Earned page (click the Detail link to the right of the H. Pct. TIV Aid
Earned field on the Return of Funds Worksheet page).


Image: Calculate Pct. TIV Aid Earned page


This example illustrates the fields and controls on the Calculate Pct. TIV Aid Earned page. You can find
definitions for the fields and controls later on this page.


Percentage of Title IV Aid Earned
Date of Withdrawal Displays the student's day of withdrawal as entered on the


Return of TIV Aid page.


 Period Start Date Displays the first day of the term or payment period.


 Period End Date Displays the last day of the term or payment period.
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60 Pct Effective Date(60 percent
effective date)


Displays the 60 percent date for the session in which the
withdraw is taking place as recorded in the Term/Session Table
or as entered in the Return TIV Session table.


Note: This date is not necessarily a 60 percent point in time for
the span of multiple sessions.


Session Period Begin Date Displays the lowest beginning date of the Session Period as
entered in the as entered in the Return TIV Session table.


Session Period End Date Displays the highest end date of the Session Period as entered in
the Return TIV Session table.


Completed Days for Period Displays calculated earned days for a session.


Total Days for Period Displays calculated total days for a session period.


Total Session Break Displays the total of all breaks between sessions greater than 4
days.


 Completed Days Displays the number of days between the Period Start Date
and student's Date of Withdrawal. Enter a value in this field to
manually override and set the Override flag to "Y".


Note: Completed Days are net days considering eligible Session
Breaks. Holiday Breaks are not reflected in this total. They are,
 however, accounted for in the Period Adjustment to provide a
point of reference.


 Student Adjustment Enter a value in this field to exercise professional judgment by
adjusting the student's completed days.


Note: Completed Days are net days considering eligible Session
Breaks. Holiday Breaks are not reflected in this total. They are,
 however, accounted for in the Period Adjustment to provide
a point of reference when making an adjustment to a student’s
Completed Days.


 Total Days Displays the number of days between the Period Start Date
and Period End Date, inclusive. Enter a value in this field to
manually override and set the Override flag to "Y".


Note: Total Days are net days considering eligible Session
Breaks. Holiday Breaks are not reflected in this total. They are,
 however, accounted for in the Period Adjustment to provide a
point of reference.


 Period Adjustment Displays the adjustment that is required for scheduled holidays
of five consecutive days or more. The system displays 0 if no
holidays are scheduled consecutively for 5 or more days. Enter a
value in this field to manually override and set the Override flag
to "Y".
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Note: Total Days are net days considering eligible Session
Breaks. Holiday Breaks are not reflected in this total. They are,
 however, accounted for in the Period Adjustment to provide
a point of reference when making an adjustment to a student’s
Total Days.


 Days Earned / In Term Displays the number of completed days divided by the total
days after performing a calculation.


Note: This field is reset to zero every time you access the
component. Click Calculate to update.


 H. Pct TIV Aid Earned (H. percent
Title IV aid earned)


Displays the percentage of the period of enrollment or payment
period that the student completed.


 Calculate Click to recalculate the percentage of the period of enrollment
or payment period that the student completed if updating
Completed Days, Student Adjustment, Total Days, or Period
Adjustment.


Holiday Adjustment
 Holiday Schedule Displays the name of the holiday schedule defined on the


Holiday Schedule page (Set Up Common Objects >Foundation
Tables >Organization >Holiday Schedule) for that term.
 Student Records associates this schedule to terms and sessions
used in Campus Solutions.


See "Setting Up Holiday Schedules" (PeopleSoft Campus
Solutions 9.2: Campus Community).


 Holiday Displays the date of the holiday. The system lists all holidays,
 not just those that are consecutive.


 Hours Displays the number of clock hours for the holiday.


 Holiday Adjustment (Days) Displays the number of consecutive holidays defined in the
holiday schedule.


 Calculate Click to recalculate the adjustment for holidays if you made a
change to the start and end dates of the payment or enrollment
period. The system determines whether there are any changes to
the holiday schedule based on the new start and end dates.


Note: The system does not support clock hours even though you can select clock hours as a program type
when you enter the access requirements to enter the Return of TIV Aid page.


Viewing Institutional and Budget Charges
Access the Calculate Charge Information page (click the Detail link to the right of the L. Total
Institutional Chrgs (charges) field on the Return of Funds Worksheet page).
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 Charge Type Displays institutional charges for the student associated with an
item type group for the term.


 Category Displays the budget category for which the charge type is
associated.


 Academic Career Displays the grouping of all academic work undertaken by a
student at an institution.


 Item Code Displays a budget item within a budget category.


 Amount Displays the charge amount for the charge type.


Override Amount Enter an amount to override institutional charges when 'Use
Actual Charges' is selected in Define Rules for Return .


 L. Total Institutional Chrgs  (L. total
institutional charges)


• Displays actual budgeted charges if Use Budget Charges is
selected in setup.


• Displays actual institutional charges or the combined
Override amounts of actual institutional charges if'Use
Actual Charges is selected in setup and Override amounts
are used.


 Total Institutional Charges • Displays actual budgeted charges if Use Budget Charges is
selected in Define Rules of Return.


• Displays actual institutional charges if Use Actual Charges
is selected in Define Rules of Return.


 Calculate Click to recalculate total institutional charges and to update the
Return of Funds Worksheet page.


Related Links
Defining Budget Items


Calculating Return Amounts
Access the Calculate Return Amounts page (click the Detail link to the right of O. Amt. Due From School
or P. Amount Due From Student fields on the Return of Funds Worksheet page).


 School Return of Funds Displays the amount to be returned by the school by aid fund
and amount.


 O. By School Displays total amount from the School Return of Funds group
box.


 P. School Rtrn (school return) Displays total loans to be returned by school from the School
Return of Funds group box.


 Q. By Student Displays initial grant amount student must return.


 R. Repayment Displays loan amount student must repay.
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 Calculate Click to recalculate the totals if you updated or modified the
values.


Reviewing Loan Debts for Withdrawn Students
Access the Return of Loan Funds page (click the Detail link for the R. Stdt Loan Repaymnt Amount field
on the Return of Funds Worksheet).


Enter the totals for any Unsubsidized FFEL or Direct Loan, Subsidized FFEL or Direct Loan, Perkins,
Graduate PLUS, or PLUS loans for which the student is responsible.


This worksheet is useful when counseling a withdrawn student on loan indebtedness.


Reviewing Grant Funds for Withdrawn Students
Access the Return of Grant Funds page (click the Detail link for the U. TIV Grant Return Amt field on the
Return of Funds Worksheet).


Displays the amount of grant funds being returned.


Tracking Student and School Return Information


This section discusses how to:


• Track return information.


• Track post-withdrawal disbursement.


• View allocation of post-withdrawal disbursements.


• Review post-withdrawal disbursements.


• Enter return of TIV aid notes.


Pages Used to Track Student and School Return Information
Page Name Definition Name Navigation Usage


Student/School Return STDNT_RTRN_TIV_WK2N Financial Aid > Return of
Title IV Funds > Create
Worksheet > Student/School
Return


Track return information for
the student and school.


Post-Withdrawal
Disbursement


STDNT_RTRN_TIV_WK3A Financial Aid > Return
of Title IV Funds >
Create Worksheet > Post-
Withdrawal Disbursement


Track post-withdrawal
disbursements a student was
entitled to at the time of
withdrawal.


Allocation of PWD STDNT_PWD_SEC1AN Click the Part IV Allocation
of PWD link on the Post-
Withdrawal page.


Enter post-withdrawal
disbursement amounts for
grants and loans.
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Page Name Definition Name Navigation Usage


Post-Withdrawal
Disbursements (detail)


STDNT_PWD_SEC1 Click the PWD Detail link on
the Post-Withdrawal page.


Review post-withdrawal
disbursements. Includes the
amount of eligible aid not yet
disbursed, eligible aid to be
disbursed late, and remaining
eligible aid to be disbursed.


Return TIV Aid Notes STDNT_RTRN_TIV_WK4 Financial Aid > Return of
Title IV Funds > Create
Worksheet > Return TIV Aid
Notes


Enter return of Title IV aid
notes. Document information
regarding the processing of
Title IV Return of Funds.


Tracking Return Information
Access the Student/School Return page (Financial Aid > Return of Title IV Funds > Create Worksheet >
Student/School Return).


Image: Student/School Return page


This example illustrates the fields and controls on the Student/School Return page. You can find
definitions for the fields and controls later on this page.


Student Return of Funds
 Student Notified Select this check box to indicate the student has been notified of


their Title IV overpayment obligation.


 Student Return Status Displays the student's return of Title IV funds status.


Pending: Indicates that the calculation and the return of Title
IV funds are still in progress. The default status is Pending until
you manually change the status to Complete.


Complete: Indicates that calculation, student notification, and
the return of Title IV funds has occurred.
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Note: You should update the Student Return Status field to
Complete when a student does not need to return funds.


 Notification Date Displays the date the student was notified of Title IV
overpayment.


Q. Amt Due From Student(Q. amount
due from student)


Displays the amount of Title IV funds the student must return. If
a student owes a return, the system populates this value from the
Return of Funds Worksheet page.


Student Response Information
 Response Date Displays the date the student responded to the notification from


the institution about Title IV overpayment.


 Repayment Arrangement Select from available values to indicate the student's action
taken in response to repayment arrangements. Values include:


Arrangement not Complied


Make Arrangements DOE


Make Arrangements School


No Satisfactory Arrangements


Pay School in Full


Title IV Loans Only


School Return of Funds
 School Return Status Indicates the institution's repayment status as pending or


complete. The default status is pending until you manually
change the status to complete.


 Funds Return Date Indicates the date the funds were returned.


 O. Amt Due From School Indicates the amount of Title IV funds the institution must
return. If the school owes a return, the system automatically
populates this value from the Return of Funds Worksheet page.


 Calculate Click to recalculate the amount the school and student have to
return if you made a change to the percentage on the Return of
Funds Worksheet page.


Tracking Post-Withdrawal Disbursement
Access the Post-Withdrawal Disbursement page (Financial Aid > Return of Title IV Funds > Create
Worksheet > Post-Withdrawal Disbursement).
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Image: Post-Withdrawal Disbursement page


This example illustrates the fields and controls on the Post-Withdrawal Disbursement page. You can find
definitions for the fields and controls later on this page.


 Calculate Click to recalculate the amount of aid to a post-withdrawal
student if you made a change to the percentage.


 Post-Withdrawal Disb Status  (post-
withdrawal disbursement status)


Indicates whether or not post-withdrawal disbursement
calculations are complete or pending.


The Pending status is set when the worksheet is created. Select
Complete when appropriate for the current stage of processing.


Part I, II, III
J. TIV Aid to Disburse (Box 1) Displays the total amount of post-withdrawal disbursement due.


 This field is from Step J. Post Withdrawal Disbursement on the
Return of Funds Worksheet page.


Total PWD Credited (Box 2) Enter the total outstanding charges scheduled to be paid from
Post Withdrawal Disbursement.


Box 3 The amount to offer directly to the student is derived from
the TIV Aid to Disburse amount less the Total PWD Credited
amount. Box 3 = Box 1 - Box 2.


Part IV Allocation of PWD (part
4 allocation of post withdrawal
disbursement)


Click this link to access the Allocation of Post Withdrawal
Disbursement page.


PWD Detail (post withdrawal
disbursement detail)


Click this link to view Post Withdrawal Disbursement
Allocation details.
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Part V, VI
PWD Notification Sent Select the date that the post-withdrawal disbursement loan


notification was sent to the student or parent.


Response Deadline Select the date by which the student, parent, or both must
respond.


Date Response Received Select the date that the response was received from the student
or parent.


Response Received Select this check box if the response was received from the
student or parent.


Not Received Select this check box if the response was not received from the
student or parent.


Late Response Not Accepted Select this check box if the response was received from the
student or parent after the date in the Response Deadline field.


Date Direct Disb Mailed (date direct
disbursement mailed)


Select the date for grant, loan, or both that the direct
disbursement was mailed or transferred.


Viewing Allocation of Post-Withdrawal Disbursements


Bundle 50


New screen shot.


Access the Allocation of PWD page (click the Part IV Allocation of PWD link on the Post-Withdrawal
page.)


Image: Allocation of PWD page


This example illustrates the fields and controls on the Allocation of PWD page. You can find definitions
for the fields and controls later on this page.


Enter appropriate amounts for each column and type of aid:


Ln Amt Sought (loan amount sought) Enter the loan amount school seeks to credit to the account.


Ln Amt Auth (loan amount
authorized)


Enter the loan amount authorized to credit to the account
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Aid Credited Enter the aid credited to the account.


Aid Offered Enter an amount of aid offered as direct disbursement.


Aid Accepted Enter an amount of aid accepted as direct disbursement.


Aid Disbursed Enter amount of aid disbursed directly to the student


Calculate Click this button to total the columns.


Reviewing Post-Withdrawal Disbursements
Access the Post-Withdrawal Disbursements detail page (click the PWD Detail link on the Post-
Withdrawal Disbursements page).


 Eligible Aid Not Disbursed Displays aid not disbursed at time of withdrawal.


 Aid To Be Late Disbursed Displays aid amounts eligible for a post-withdrawal late
disbursement.


 Remaining To Be Disbursed Displays aid amounts eligible for a post-withdrawal late
disbursement.


Entering Return TIV Aid Notes
Access the Return TIV Aid Notes page (Financial Aid > Return of Title IV Funds > Create Worksheet >
Return TIV Aid Notes).


Image: Return TIV Notes page


This example illustrates the fields and controls on the Return TIV Notes page.


Enter comments of any length into the text area.
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Tracking Return of Title IV Funds


This section discusses how to:


• Track student return of Title IV funds.


• Track school return of Title IV funds.


• Review post-withdrawal disbursement tracking data.


Pages Used to Track Return of TIV Funds
Page Name Definition Name Navigation Usage


Track Student Returns SFA_TIV_RTN_TRACK Financial Aid > Return
of Title IV Funds > Track
TIV Funds Return > Track
Student Returns


Track student return of Title
IV funds. View the status of
funds for all students where a
calculation exists.


Return of Funds Detail STDNT_RTOF_SEC1NA Click the Detail link from
the Track Student Returns
Summary 2 page or Track
School Returns Summary
page.


View student aid amount and
the return of funds for both
the student and school.


Track School Returns SFA_TIV_RTN_TRACK2 Financial Aid > Return of
Title IV Funds > Track TIV
Funds Return > Track School
Returns


Track school return of TIV
funds. View the status of
funds for your institution.


Post Withdrawal Disb
Tracking


SFA_TIV_PWD_TRACK Financial Aid > Return
of Title IV Funds > Track
PW Disbursement > Post
Withdrawal Disb Tracking


Review post-withdrawal
disbursement tracking data.


Tracking Student Return of Title IV Funds
Access the Track Student Returns page (Financial Aid > Return of Title IV Funds > Track TIV Funds
Return > Track Student Returns).
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Image: Track Student Returns page: Status tab


This example illustrates the fields and controls on the Track Student Returns page: Status tab. You can
find definitions for the fields and controls later on this page.


 View Select one of the following:


All: View students with a status of pending or completed.


Complete: View students who have completed the Return of
Title IV Funds process.


Pending: View students who are being processed.


Status Tab
 ID Indicates a unique identification code for a student associated


with your institution.


 Name Displays the name of a student.


 Return Status Displays the student's return of Title IV funds status. This status
comes from the Student/School Return page. If a student does
not have a return, the student does not appear in the list.


Pending: The calculation and the return of Title IV funds are
still in progress. This status comes from the Student/School
Return page; you can change it manually on this page.


Complete: The calculation, student notification, and the return
of Title IV funds has occurred.


Summary 1 Tab
Select the Summary 1 tab.
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Image: Track Student Returns page: Summary 1 tab


This example illustrates the fields and controls on the Track Student Returns page: Summary 1 tab. You
can find definitions for the fields and controls later on this page.


 Institutional Determination Dt
(institutional determination date)


Displays the withdrawal date determined by the financial aid
office.


Days Elapsed After an institution determines the date of withdrawal, the
system calculates and displays the number of days passed
since the student withdrew. The days are calculated using the
Institutional Determination Dt field as the starting date.


 Student Notified If selected, indicates the student has been notified of their Title
IV overpayment obligation.


 Notification Date Displays the date the student was notified of Title IV
overpayment.


Summary 2 Tab
Select the Summary 2 tab.
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Image: Track Student Returns page: Summary 2 tab


This example illustrates the fields and controls on the Track Student Returns page: Summary 2 tab. You
can find definitions for the fields and controls later on this page.


 Response Date Displays the date the student responded to the notification from
the institution about Title IV overpayment.


 Repayment Arrangement Displays one of the student response options from the Student/
School Return page. The values are:


Arrangement not Complied


Make Arrangements DOE


Make Arrangements School


No Satisfactory Arrangements


Pay School in Full


Title IV Loans Only


 Q. Amt Due From Student (Q.
amount due from student)


Displays the amount of funds needed to be returned by the
student.


 Detail Click to view the Return of Funds Detail page.


Last Updated Tab
Select the Last Updated tab.
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Image: Track Student Returns page: Last Updated tab


This example illustrates the fields and controls on the Track Student Returns page: Last Updated tab.


Tracking School Return of Title IV Funds
Access the Track School Returns page (Financial Aid > Return of Title IV Funds > Track TIV Funds
Return > Track School Returns).


Image: Track School Returns page: Status tab


This example illustrates the fields and controls on the Track School Returns page: Status tab. You can find
definitions for the fields and controls later on this page.


 View Select one of the following:


All: View students with a status of pending or completed.
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Complete: View students who have completed the Return of
Title IV Funds process.


Pending: View students who are being processed.


Status Tab
 Return Status Displays the school's return of Title IV funds status.


Pending: Indicates that the calculation and the return of Title IV
funds are still in progress. This status comes from the Student/
School Return page; you can change it manually on this page.


Complete: Indicates that calculation and the school return of
Title IV funds has occurred.


Summary Tab
Select the Summary tab.


Image: Track School Returns page: Summary tab


This example illustrates the fields and controls on the Track School Returns page: Summary tab. You can
find definitions for the fields and controls later on this page.


 Institutional Determination Dt
(institutional determination date)


Displays the withdrawal date determined by the institution.


 Funds Return Date Displays the date the user updated the Funds Return Date field
on the Student/School Return page.


 O. Amt Due From School (O. amount
due from school)


Displays the amount of aid the institution must return to the
Title IV program.


 Detail Click to view the Return of Funds Detail page.
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Last Updated Tab
Select the Last Updated tab.


Image: Track School Returns page: Last Updated tab


This example illustrates the fields and controls on the Track School Returns page: Last Updated tab.


Reviewing Post-Withdrawal Disbursement Tracking Data
Access the Post Withdrawal Disb Tracking page (Financial Aid > Return of Title IV Funds > Track PW
Disbursement > Post Withdrawal Disb Tracking).


Image: Post Withdrawal Disb Tracking page: Status tab


This example illustrates the fields and controls on the Post Withdrawal Disb Tracking page: Status tab.
You can find definitions for the fields and controls later on this page.
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Note: The Calculate link is not available when you access the Post-Withdrawal Disbursements page from
the Post Withdrawal Disb Tracking page.


 View Select one of the following:


All: View students with a status of Pending  or  Completed.


Complete: View students who have completed the Return of
Title IV Funds process.


Pending: View students who are being processed.


Status Tab
 Status Displays the student's post-withdrawal disbursement status.


 The system displays a status of Pending to indicate that the
calculation and the post-withdrawal disbursement are still
in progress. A status of Complete indicates that calculation,
 student notification, and the post-withdrawal disbursement has
occurred. The status is from the Post-Withdrawal Disbursement
page.


Summary Tab
Select the Summary tab.


Image: Post Withdrawal Disb Tracking page: Summary tab


This example illustrates the fields and controls on the Post Withdrawal Disb Tracking page: Summary tab.
You can find definitions for the fields and controls later on this page.


 Disbursement Amount Displays the amount of funds the institution can offer the
student as a post-withdrawal disbursement.


 Detail Click to view the Post-Withdrawal Disbursements page.
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Dates Tab
Select the Dates tab.


Image: Post Withdrawal Disb Tracking page: Dates tab


This example illustrates the fields and controls on the Post Withdrawal Disb Tracking page: Dates tab.
You can find definitions for the fields and controls later on this page.


PWD Notification Sent View or edit the date that the post-withdrawal disbursement loan
notification was sent to the student, parent, or both.


Response Deadline View or edit the date by which the student, parent, or both must
respond.


Service Impact Tab
Select the Service Impact tab.
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Image: Post Withdrawal Disb Tracking page: Service Impact tab


This example illustrates the fields and controls on the Post Withdrawal Disb Tracking page: Service
Impact tab. You can find definitions for the fields and controls later on this page.


Date Response Received View or edit the date that the school received the response from
the student.


Date Direct Disb Mailed-Grant (date
direct disbursement mailed for a grant)


View or edit the date that the direct disbursement was mailed or
transferred.


Date Direct Disb Mailed-Loan (date
direct disbursement mailed for a loan)


View or edit the date that the direct disbursement was mailed or
transferred.


Last Updated Tab
Select the Last Updated tab.
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Image: Post Withdrawal Disb Tracking: Last Updated tab


This example illustrates the fields and controls on the Post Withdrawal Disb Tracking: Last Updated tab.


Reviewing Return of Title IV Funds Student Summary


This section discusses how to review the summary student return of TIV funds.


Page Used to Review Return of TIV Funds Student Summary
Page Name Definition Name Navigation Usage


Return of TIV Funds
Summary


RTRN_TIV_STU_TRACK Financial Aid > Return of
Title IV Funds > Review
Summary of TIV Return


View summary of the
student's return of TIV funds
calculation.


Reviewing the Summary of Student Return of TIV Funds
Access the Return of TIV Funds Summary page (Financial Aid > Return of Title IV Funds > Review
Summary of TIV Return).
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Image: Return of TIV Funds Summary page: Status tab


This example illustrates the fields and controls on the Return of TIV Funds Summary page: Status tab.
You can find definitions for the fields and controls later on this page.


 View Select one of the following:


All: View students with a status of Pending or Complete.


Complete: View students who have completed the Return of
Title IV Funds process.


Pending: View students who are being processed.


Status Tab
 Status Indicates the student's overall status of the Return of Title IV


calculation.


Pending: The calculation and the return of Title IV funds are
still in progress.


Complete: The calculation, student notification, and the return
of Title IV funds has occurred.


 Go To Worksheets Click to access the Return TIV Aid page.


Summary Tab
Select the Summary tab.
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Image: Return of TIV Funds Summary page: Summary tab


This example illustrates the fields and controls on the Return of TIV Funds Summary page: Summary tab.
You can find definitions for the fields and controls later on this page.


 Undetermined Withdrawal Date If the student withdrew unofficially, the system displays this
check box as selected. This information comes from the Return
TIV Aid page. The system displays a date to indicate the
midpoint of the payment period if the student unofficially
withdraws. You can update this field if you want to use a
different withdrawal date. For example, you can use the date the
student last attended an academic-related event if this date was
verified by your institution.


 Withdrawal/Cancel Date Displays the last date of recorded attendance, the date the
student began the withdrawal process, the date the student
provided to your school with the intent to withdraw, or the
midpoint of the payment period if the student unofficially
withdraws. The system displays the default date based on the
date that was established in Student Records.


Calculation Period Tab
Select the Calculation Period tab.
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Image: Return of TIV Funds Summary page: Calculation Period tab


This example illustrates the fields and controls on the Return of TIV Funds Summary page: Calculation
Period tab. You can find definitions for the fields and controls later on this page.


 Period Used for Calculation Displays the time period the system uses to define the start and
end date of the payment period or enrollment period.


 Period Start Date Displays the first day of the term or payment period. The system
uses the payment period or enrollment period start date from the
Return of TIV Aid page.


 Period End Date Displays the last day of the term or payment period. The system
uses the payment period or enrollment period end date from the
Return of TIV Aid page.


 Date Form Completed Displays the date when you calculated the student's withdrawal
percentage and changed the overall status to Complete from the
Return of TIV Aid page.


 J. TIV Aid to Disburse Displays the amount of aid the student may be eligible for as
a post-withdrawal disbursement. If the student received less
than his or her eligibility, the system displays the amount to be
disbursed.


 Status Displays the status of the post-withdrawal disbursement
calculation for Title IV aid to be disbursed as Pending or
Complete.


Worksheet Data Tab
Select the Worksheet Data tab.
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Image: Return of TIV Funds Summary page: Worksheet Data tab


This example illustrates the fields and controls on the Return of TIV Funds Summary page: Worksheet
Data tab. You can find definitions for the fields and controls later on this page.


 O. Amt. Due From School  (O.
amount due from school)


Displays the amount of aid the institution must return to the
Title IV programs. The institution allocates its share of unearned
funds first.


 Status Displays the school's return status of the calculation for the
amount due from the school as Pending or Complete.


 Q. Amt. Due From Student  (Q.
amount due from student)


Displays the amount of aid the student must return to the Title
IV programs.


 Status Displays the student's return status of the calculation for the
amount due from the student as Pending or Complete.


Generating Return of Title IV Funds Withdrawal Report


This section discusses how to:


• Generate the Return of Title IV Funds Report.


• View career totals.


Pages Used to Generate the Return of Title IV Aid Report
Page Name Definition Name Navigation Usage


Return of TIV Funds Report RUN_CNTL_FATIVRTN Financial Aid > Return of
Title IV Funds > Return of
TIV Aid Report > Return of
TIV Funds Report


Generate the Return of Title
IV Funds Withdrawal report.


Totals for Career RUN_CNTL_CARTOLS Click the Totals link on the
Return of TIV Funds Report
page.


View the total number of days
passed for each aging agent
category and view the total
number of students processed.
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Generating Return of TIV Funds Report
Access the Return of TIV Funds Report page (Financial Aid > Return of Title IV Funds > Return of TIV
Aid Report > Return of TIV Funds Report).


Image: Return of TIV Funds Report page


This example illustrates the fields and controls on the Return of TIV Funds Report page. You can find
definitions for the fields and controls later on this page.


The report displays the most recent withdrawal dates first and the oldest last. The system displays the
information based on how you define your run control options. It includes worksheet calculations, return
of funds by the school and student, institutional charges, and number of days since the withdrawal date.


 Active Select to activate the run control for that row.


 Report Structured By Select from the following options how the report was structured:


By Date


By Name


By Date Range/Name


 Process Students Select from the following status options.


Completed Withdrawals: Select to view students who have
completed withdrawal worksheets.


New Withdrawals Only: Select to view students who have a
withdrawal date but no withdrawal worksheet records.
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New and Pending Withdrawals: Select to view students who
have a withdrawal date, but the withdrawal process is not
complete.


Pending Withdrawals: Select to view students whose Return of
Title IV calculations are not complete.


 Process Selected Careers Select to process the report by specific careers. If this check box
is clear, the system processes all careers.


 Clock Hour Program Select to view records with a program type by clock hours.


 Credit Hour Program Select to view records with a program type by credit hours.


 Students 0-10 Days, Students 11-20
Days, Students 21-30 Days,  and 
Students Over 30 Days


Used as an aging agent to indicate how many days have passed
since the institution determined the date of withdrawal.


 Total Students Processed Displays the total number of students processed for this report.


 Process Instance Displays an increment counting of the last time the process was
run.


 Run Date and Time Displays the date and time the process was run.


 Refresh Click to refresh the totals after each time you run the process.


 Totals Click to view the total number records based on career.


Viewing Career Totals
Access the Totals for Career page (click the Totals link on the Return of TIV Funds Report page).
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Processing and Using Institutional
Financial Aid Applications


Maintaining Institutional Financial Aid Applications


Your institution can gather additional resource information about students and their families by using the
College Board PROFILE application which is electronically supported by the System or by entering your
institutional application on the pages in this component.


Note: The College Board PROFILE and institutional application data share the same pages. You might
unintentionally create multiple institutional aid records for a student from these three sources, which
could cause unintended INAS calculation results.


Note: Question marks or blanks on College Board PROFILE data files are converted or appear as zeros in
currency based numeric fields.


For further information about the fields in this component, please refer to the College Board's Financial
Aid Services Information Center (https://groups.collegeboard.org/fas) for supporting documentation.


This section lists common elements and discusses how to:


• Review student information.


• Review custodial parent information.


• Review non custodial parent information.


• Review currency information, family information, and institutional questions.


• Review all computed data for student and parents.


Related Links
Loading and Managing PROFILE Records
Using INAS Batch Calculations


Common Elements Used in This Section
 Need Summary Click this link to access the Need Summary page, where


you can review the student's federal and institutional need
calculations.


 FM  (federal methodology) Click this link to access the INAS Fed Extension page, where
you can override INAS Local Policy Options for federal data.
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 IM  (institutional methodology) Click this link to access the Institutional Need Calculation
Extension 1 page, where you can override INAS Local Policy
Options for institutional data.


 INAS  (institutional need analysis
system)


Click this button to calculate an unofficial federal and
institutional Expected Family Contribution (EFC) by using the
College Board's Institutional Need Analysis System (INAS). A
COBOL program is used to perform the INAS calculation.


INAS NCP (institutional need analysis
system non custodial parent button)


Click this button to calculate the non custodial parent
contribution.


Note: Calculate the non-custodial parent contribution before
invoking the regular INAS calculation.
Calculating a non custodial parent contribution creates an
INAS Extension record, selects the Use Non-Custodial Parent
Contribution check box and populates the PC From Non-
Custodial Parent (parent contribution from non-custodial
parent) field in INAS Extension 5. After this, when the
regular INAS calculation is invoked, the non-custodial parent
contribution is added to the Custodial Parent contribution and
overall expected family contribution.


The system displays the student's name, ID, HouseHold Type (HHA for Custodial Parent, HHB for Non
Custodial Parent, HHA/HHB for both Custodial and Non Custodial Parent), institution, dependency
status, application source, and aid year at the top of each review page. These two terms also appear at the
top of each review page:


HouseHold Type (household type) Displays the type of PROFILE application received:


• HHA/HHB – both custodial parent and non custodial parent
applications received.


• HHA – only custodial parent application received.


• HHB – only non custodial parent application received.


HHB Indicated (non custodial
parent PROFILE application received
indicator)


Displays whether or not a non custodial parent PROFILE
application is indicated or can exist for a custodial parent
household.


• Yes – non custodial parent PROFILE application is indicated
or can exist for a custodial parent household.


• No – non custodial parent PROFILE application not
indicated or cannot exist for a custodial parent household.


Related Links
Defining Federal and Institutional Methodologies
Overriding Expected Family Contribution (EFC)
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Pages Used for Institutional Applications


Note: The navigation paths for the pages listed in the following page introduction table are for aid year
20nn-20nn. Oracle supports access for three active aid years with valid INAS calculations. Earlier aid
year institutional application data is available for display only at Financial Aid > Financial Aid History >
View Archived Application Data > Institutional Application.


Page Name Definition Name Navigation Usage


Student Data INST_STUDENT_nn Financial Aid > Institutional
Application Data > Maintain
Application 20nn-20nn >
Student Data


View or enter student
information.


Custodial Parent Data INST_PARENT_nn Financial Aid > Institutional
Application Data > Maintain
Application 20nn-20nn >
Custodial Parent Data


View or enter custodial parent
information.


Non Custodial Parent Data INST_NCPARENT_nn Financial Aid > Institutional
Application Data > Maintain
Application 20nn-20nn >
Non Custodial Parent Data


View or enter non custodial
parent information.


Miscellaneous Data INST_MISC_nn Financial Aid > Institutional
Application Data > Maintain
Application 20nn-20nn >
Miscellaneous Data


View or enter signature,
 family member, school
selection, and institutional
question (the College Board
PROFILE Section Q)
information. You can also
view FNAR messages on this
page.


Computation Summary INST_COMP_SUMM_nn Financial Aid > Institutional
Application Data > Maintain
Application 20nn-20nn >
Computation Summary


View or enter computed
parent and student income,
 allowance, and asset
information using your
institutional and federal
methodology. The computed
values appear here.


Reviewing Student Information
Access the Student Data page (Financial Aid > Institutional Application Data > Maintain Application
20nn-20nn > Student Data).
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Image: Maintain Institutional Application, Student Data tab (page 1 of 5)


This example illustrates the fields and controls on the Maintain Institutional Application, Student Data tab
(page 1 of 5). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Student Data tab (page 2 of 5)


This example illustrates the fields and controls on the Maintain Institutional Application, Student Data tab
(page 2 of 5). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Student Data tab (page 3 of 5)


This example illustrates the fields and controls on the Maintain Institutional Application, Student Data tab
(page 3 of 5). You can find definitions for the fields and controls later on this page.
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Image: Maintain Institutional Application, Student Data tab (page 4 of 5)


This example illustrates the fields and controls on the Maintain Institutional Application, Student Data tab
(page 4 of 5). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Student Data tab (page 5 of 5)


This example illustrates the fields and controls on the Maintain Institutional Application, Student Data tab
(page 5 of 5). You can find definitions for the fields and controls later on this page.


Bio/Demo and Citizenship Data
The data for the fields in this group box are populated from Campus Community Bio/Demo data.


 National ID Displays the student's National ID.


Note: If the PROFILE Application type = 4 (International
PROFILE) and the National ID is blank, the student is loaded
into PROFILE Staging with XXX-XX-XXXX. This permits
Search/Match to take place and potentially load the student into
the Institutional Application tables with the NID rendered as
XXX-XX-XXXX.


Reported Country Displays the student's reported country if not United States of
America.


Bio/Demo Citizenship Status Click this link to access the Campus Community Citizenship/
Passport page to confirm the citizenship status of the student's
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Biographic/ Demographic data against the values in the
Reported Country and Reported Status fields.


CSS Data
 CSS ID (college scholarship service
ID)


Bundle 50


Added Note.


Note: CSS ID was the identifier assigned by College Board
to ensure both privacy and quick retrieval of records. CSS ID
was removed from PROFILE XML files by College Board
effective Aid Year 2019-2020. It will not be displayed for Aid
Year 2019-2020 forward.


CB FinAid ID (College Board
Financial Aid ID)


Displays a unique lifetime ID assigned to the student's record by
the PROFILE system to ensure both privacy and quick retrieval
of records. When you call the College Board inquiry number
with questions about specific records, it is helpful to know the
student's College Board Financial Aid ID number.


Application Type Displays:


• 1 if the application is a Domestic PROFILE.


• 2 if the application is a Canadian PROFILE.


• 3 if the application is an International PROFILE.


Student's Information
 Financial Aid Status Enter the student's status as it relates to receiving financial aid.


 Marital Status Code Select the marital status to be used for financial aid purposes.
 This marital status can differ from the Bio/Demo Data page
marital status.


Student IM Zip (student institutional
methodology zip code)


The student zip code used for cost of living adjustment
calculations. Typically matches the student permanent zip code
but can be updated independently of student permanent zip code
if needed.


Parent IM Zip (parent institutional
methodology zip code)


The parent zip code used for cost of living adjustment
calculations. Typically matches the parent permanent zip code
but can be updated independently of parent permanent zip code
if needed.


Student's Income/Benefits/Resources – Base (Prior Prior Year)
These fields are items from the United States federal income tax forms or data gathered from other
applicable sources such as an institutional application or a third party source.
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Student's Income/Benefits/Resources – Base+2 (Anticipated Year)
Receive Tuition Benefits Indicate whether or not the student receives tuition benefits from


the parents' employers.


Agencies/Foundation Support Indicate whether the student expects to receive from agencies or
foundations to pay for educational expenses during any year of
attendance.


Government Support Indicate whether the student expects to receive from her
government to pay for educational expenses during any year of
attendance.


Student's Assets – Current
 Price Enter purchase price of the student's home.


Student's Expenses – Base (Prior Prior Year)
Child Support Paid Enter the child support paid by the student.


Medical/Dental Enter the medical and/or dental out of pocket expenses paid by
the student.


Veterans Benefits Enter the monthly amount of VA Benefits received by the
student.


Months Enter the number of months the veterans benefits were received
in the calendar year.


Currency Information


Bundle 50


Relocated this section from the “Custodial Parent Data” tab.


 Currency Code Enter the currency in which the original data was reported by
the student.


Currency Rate Enter the currency conversion rate used to process the student's
data.


Parent Country Co-Efficient Bundle 50


Updated field and field description.


Enter the country coefficient used to process the parents’
financial data.


Converted Currency Code Enter the original currency converted into US dollars reported
by citizens living abroad and Canadians.
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Converted Currency Rate Enter the rate the student used in converting their currency into
US dollars. Reported by citizens living abroad and Canadians.


Student Country Co-Efficient Bundle 50


Added field.


Enter the country coefficient used to process the student’s
financial data.


Non-Custodial Student Data
These fields display student information as reported on the Non-Custodial PROFILE.


Reviewing Custodial Parent Information
Access the Custodial Parent Data page (Financial Aid > Institutional Application Data > Maintain
Application 20nn-20nn > Custodial Parent Data).


Image: Maintain Institutional Application, Custodial Parent Data tab (page 1 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 1 of 6). You can find definitions for the fields and controls later on this page.
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Image: Maintain Institutional Application, Custodial Parent Data tab (page 2 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 2 of 6). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Custodial Parent Data tab (page 3 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 3 of 6). You can find definitions for the fields and controls later on this page.
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Image: Maintain Institutional Application, Custodial Parent Data tab (page 4 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 4 of 6). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Custodial Parent Data tab (page 5 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 5 of 6). You can find definitions for the fields and controls later on this page.


10  Copyright © 2018, Oracle and/or its affiliates. All rights reserved.







Chapter _ Processing and Using Institutional Financial Aid Applications


Image: Maintain Institutional Application, Custodial Parent Data tab (page 6 of 6)


This example illustrates the fields and controls on the Maintain Institutional Application, Custodial Parent
Data tab (page 6 of 6). You can find definitions for the fields and controls later on this page.


Bundle 50


Added new “Parents Grid” section to the page.


Parents Grid
This section of the page displays parental information including relationship to student as reported on the
PROFILE.


Parent's Income and Benefits – Base (Prior Prior Year)


Bundle 50


Documentation Update Only.


Updated terms.


These fields are items from the United States federal income tax forms or data gathered from other
applicable sources such as an institutional application or a third party source.


Child Support Received Enter the child support received by the parents for their
dependent children.


Child Support Received Student Enter the amount of child support the custodial household
received from the non-custodial household for the applicant.


Parent's Income and Benefits – Base+1 (Recent Year)
These fields are items from the United States federal income tax forms or data gathered from other
applicable sources such as an institutional application or a third party source.


Parent's Income and Benefits – Base+2 (Anticipated Year)
These fields are items from the United States federal income tax forms or data gathered from other
applicable sources such as an institutional application or a third party source.
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Non-Custodial Parent Contribution The amount the non-custodial parent has offered to pay for the
student's educational expenses.


Parent's Assets – Current
Owed to Parent by Others Enter the amount owed to parents by others


Annual Debt Income The annual income realized by the parents from debts owed to
them.


Value of Other Assets Enter the value of any assets not already reported.


Price Enter purchase price of the parents' home.


 Real Estate Purchase Year Enter purchase year of any other real estate.


 Price Enter purchase price of any other real estate.


Parents' Expenses – Base (Prior Prior Year)
Enter the parents' expenses from the Base Year for these fields.


Other Expenses Enter the cost of any parental expenses not reported anywhere
else on the PROFILE.


Parents' Expenses – Base+1 (Recent Year)
Enter the parents' expenses from the Recent Year for these fields.


Academic Year
 Other Tuition Paid The amount of private elementary/secondary tuition expected to


be paid by the parents during the academic year.


 Number of Tuition Paid The number of children for which private elementary/secondary
tuition is expected to be paid by the parents during the academic
year.


Parents' Information
Parent Type 1 and Parent Type 2 Select the type of parent providing information on the


PROFILE. Values include: Father, Legal Guardian, Mother,
Other, Step Father, Step Mother.


Computed Age 1 and Computed Age
2


Indicates the calculated age for the parent.


Biological Adoptive Parent Bundle 50


Renamed field. Formerly “Custodial Parent”.
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Identifies a dependent student's custodial parent when the
biological/adoptive parents are separated, divorced, or were
never married. Values include: Parent 1 and Parent 2.


Currency Information
 Currency Code Enter the currency in which the original data was reported by


the student.


Currency Rate Enter the currency conversion rate used to process the student's
data.


Country Coefficient Enter the country coefficient used to process the student's data.


Converted Currency Code Enter the original currency converted into US dollars reported
by citizens living abroad and Canadians.


Converted Currency Rate Enter the rate the student used in converting their currency into
US dollars. Reported by citizens living abroad and Canadians.


Explanation / Certification


Bundle 50


Added individual Special Circumstances reasons to user interface.


PROFILE applicants can indicate on their applications a variety of Special Circumstances that may affect
the calculation of financial need. These include:


• Change in Employment


• Scholarships


• Medical/Dental Expenses


• Siblings Private School


• Catastrophic Event


• Elder Care


• Non-Recurring Income


• Financial Support


PROFILE applicants can also indicate if they have no Special Circumstances or Special Circumstances
not listed in the PROFILE application.


Explanations Text Displays the actual explanations and special circumstances text
provided by the filer.
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Reviewing Non Custodial Parent Information
Non-Custodial Parent Contribution Summary


Access the Non Custodial Parent Data page (Financial Aid > Institutional Application Data > Maintain
Application 20nn-20nn > Non Custodial Parent Data).


Please refer to the “Reviewing Custodial Parent Information” section of this topic for similar screen shots
and field descriptions. Notable exceptions are in this section.


INAS NCP
Click this button to calculate the non custodial parent contribution.


Note: Calculate the non-custodial parent contribution before invoking the regular INAS calculation.
Calculating a non custodial parent contribution creates an INAS Extension record, selects the Use Non-
Custodial Parent Contribution check box and populates the PC From Non-Custodial Parent (parent
contribution from non-custodial parent) field in INAS Extension 5. After this, when the regular INAS
calculation is invoked, the non-custodial parent contribution is added to the Custodial Parent contribution
and overall expected family contribution.


See the Common Elements Used in This Section and the Reviewing All Computed Data for Student and
Parents sections for detailed information.


Reviewing Processing Messages and Institutional Questions
Access the Miscellaneous Data page (Financial Aid > Institutional Application Data > Maintain
Application 20nn-20nn > Miscellaneous Data).


Image: Maintain Institutional Application, Miscellaneous Data tab


This example illustrates the fields and controls on the Maintain Institutional Application, Miscellaneous
Data tab. You can find definitions for the fields and controls later on this page.
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FNAR Messages


Bundle 50


Updated description.


The system displays the Financial Need Analysis Report (FNAR) message number, message text,
and message Values 1 through 5, if any. These College Board PROFILE messages inform you about
processing exceptions to data received and assumptions that should be taken into consideration when
reviewing the institutional application. This information is displayed for the Custodial and Non-custodial
Parents, as it is provided by PROFILE.


Assumption Messages
The system displays the CSS INAS IM Assumptions alphanumeric code, message text, and value, if any.
These are the INAS Assumptions triggered during the need analysis methodology and include the full text
of the e-FNAR assumption generated by the PROFILE system and any corresponding values.


Institutional Questions
 Number Number of an application question that the student/family


believes warrants further explanation. This number may also
refer to a series of additional questions that have been modified
for the institution by College Board PROFILE.


 Answer Answer to the question shown in the Number field.


Reviewing All Computed Data for Student and Parents
Access the Computation Summary page (Financial Aid > Institutional Application Data > Maintain
Application 20nn-20nn > Computation Summary).
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Image: Maintain Institutional Application, Computation Summary tab (page 1 of 4)


This example illustrates the fields and controls on the Maintain Institutional Application, Computation
Summary tab (page 1 of 4). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Computation Summary tab (page 2 of 4)


This example illustrates the fields and controls on the Maintain Institutional Application, Computation
Summary tab (page 2 of 4). You can find definitions for the fields and controls later on this page.
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Image: Maintain Institutional Application, Computation Summary tab (page 3 of 4)


This example illustrates the fields and controls on the Maintain Institutional Application, Computation
Summary tab (page 3 of 4). You can find definitions for the fields and controls later on this page.


Image: Maintain Institutional Application, Computation Summary tab (page 4 of 4)


This example illustrates the fields and controls on the Maintain Institutional Application, Computation
Summary tab (page 4 of 4). You can find definitions for the fields and controls later on this page.


This page is designed to display computed need analysis results based on both the parent's and student's
information. Therefore, the page displays a Parent Contribution Section and a Student Contribution
Section. The following sections describe what each column represents.


Note: Computation tables display no intermediate values until the INAS calculation is called using batch
or online calculation.


Note: To more closely align interim calculation results with the Estimated Federal Methodology (EFM)
computation worksheets from the College Board, the Computation Summary page displays an N/A
value for several fields. For parents of dependent students and independent students with dependents,
EFM calculations display N/A for From Income, From Assets, Total Contribution - Income and Total
Contribution - Assets fields.
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Contribution Summary
The PARENT CONTRIBUTION section displays three columns: IM Base, IM w/Options, and EFM.


• The IM Base column displays standard base INAS calculations. Although the IM Base calculation is
not delivered as part of the PROFILE record, Oracle supports calculating the College Board's IM Base
calculation if INAS is invoked after the initial load of the PROFILE record.


• The IM w/Options column is the result of using the institutional options that you set up when you
defined your institutional methodology. IM w/Options is delivered as part of the PROFILE record.


• The EFM column displays the estimated federal methodology amount. Financial aid administrators
are reminded that the EFM is always estimated and never official.


The STUDENT CONTRIBUTION section displays three columns: IM Base,  IM w/ Options,  and EFM.


• The IM Base column displays standard base INAS calculations. Although the IM Base calculation is
not delivered as part of the PROFILE record, Oracle supports calculating the College Board's IM Base
calculation if INAS is invoked after the initial load of the PROFILE record.


• The IM w/Options column is the result of using the institutional options that you set up when you
defined your institutional methodology. IM w/Options is delivered as part of the PROFILE record.


• The EFM column displays the estimated federal methodology amount. Financial aid administrators
are reminded that the EFM is always estimated and never official.


 Total Income Indicates the custodial parent's total contribution for the student
from the base IM computation.


Custodial Parent Information
The system displays the calculations for Total Income, Total Contribution, Number in College
Adjustment, Contribution for Student, contribution From Income, and contribution From Assets for
Parent's Contribution and Student's Contribution.


For the PARENT CONTRIBUTION IM Base:


 Percent Income Indicates the custodial parent's percentage of total parents
income from the base IM computation.


 Contribution From Income Indicates the custodial parent's contribution from income for the
student from the base IM computation.


 Contribution From Assets Indicates the custodial parent's contribution from assets for the
student from the base IM computation.


For the PARENT CONTRIBUTION IM w/Options


 Percent Income Indicates the custodial parent's percentage of total parental
income from the option IM computation.


 Contribution From Income Indicates the custodial parent's contribution from income for the
student from the option IM computation.
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 Contribution From Assets Indicates the custodial parent's contribution from assets for the
student from the options IM computation.


Education Savings Calculations
The system displays the Parent's and the Student's Annual Education Savings Allowance (AESA) and
Cumulative Education Savings Allowance (CESA) calculations. These are PROFILE specific calculated
values used in INAS calculations for Institutional Methodology.


Income
The system displays the calculations for Taxable Income, Untaxed Income, Adjustments to Income, and
Total Income for Parent's Contribution and Student's Contribution.


Allowances
The system displays the calculations for U.S. Income Tax, FICA Taxes, Medical/Dental, Elementary/
Secondary Tuition, Employment Allowance, Annual Education Savings, Income Protection Allowance/
MMA, Total Allowances, Calculated Available Income, and Available Income for Parent's Contribution
and Student's Contribution. The Total Contribution - Income amount is the sum of all the fields in the
Allowances section.


Assets
The system displays the calculations for Cash Savings, IRA Value, Home Equity, Real Estate/Investment
Equity, Adjusted Business/Farm Value, Sibling's Assets/Prepaid Tuition, Value of Trusts, and Net Worth
for Parent's Contribution and Student's Contribution.


The system displays the calculations for Emergency Reserve Allowance, Cumulative Education Savings,
Low Income Asset Allowance, Discretionary Net Worth, Asset Protection Allowance, Conversion
Percentage, and Income Supplement for Parent's Contribution and Student's Contribution. The Total
Contribution - Assets amount is the sum of all the fields in the Assets section.


Non Custodial Parent Computation Summary Data
• Education Saving Calculation – Displays the non custodial parents’ Annual Education Savings


Allowance (AESA) and Cumulative Education Savings Allowance (CESA) calculations. These are
PROFILE specific calculated values used in INAS calculations for Institutional Methodology.


• IM Options Non Custodial Parents Contribution – Displays a logical grouping for the Non Custodial
Parent Contribution results under the IM options computation.


• Non Custodial Parent Base Adjustment – Displays a logical grouping for the data elements for the
biological/adoptive parent base computation results.


Loading and Managing PROFILE Records


Before you begin loading applications, define all PROFILE data load parameters and set up your run
control options using the Financial Aid Run Controls page. This section discusses how to:


• Load PROFILE records.
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• View PROFILE load summaries.


• Manage suspended PROFILE records.


• Delete PROFILE records.


Note: Oracle supports the CSS / Financial Aid PROFILE File Layout (with corresponding school year)
for PROFILE data received from the College Board.


Pages Used to Load and Manage PROFILE Records


Note: Oracle supports two academic years of PROFILE data loads.


Page Name Definition Name Navigation Usage


Load Records SFA_PF_RUNCNTL Financial Aid > File
Management > PROFILE
Import > Load Records >
Load Records


Import PROFILE records into
the database.


Load Summary SFA_PF_IN_LOAD Financial Aid > File
Management > PROFILE
Import > Load Summary >
Load Summary


From the PROFILE Staging
Table, view the load status
and other details of each
record of a PROFILE load
instance.


Suspense Management SFA_PF_SUSP_CNTRL Financial Aid > File
Management > PROFILE
Import > Suspense
Management > Suspense
Management


Process suspended or skipped
PROFILE records.


Loading PROFILE Applications
Every time the PROFILE Load process is run, all records are inserted into the PROFILE Staging
tables. Depending on your Search/Match, Add Level, and Suspense Level Rules, the student's record is
inserted into either the Institutional Application (IM) tables or managed through the PROFILE Suspense
Management component. As an example, your school may only admit 60 percent of those students who
actually list your School Code on the PROFILE application. Instead of loading every student who has
listed your school code on the PROFILE application, you can load only those students officially admitted.


Access the Profile Load page (Financial Aid > File Management > PROFILE Import > Load Records >
Load Records).


Load Option Select the Load Option.


• Load Only — Select this option to only load the specified
PROFILE files. No suspended or skipped records are
reevaluated for loading.


• Recycle Only — Select this option to only reevaluate
suspended PROFILE records for loading.
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• Load and Recycle — Select this option to both load
the specified PROFILE files and reevaluate suspended
PROFILE records.


• Load Unprocessed — Select this option to load all
Unprocessed PROFILE records in the PROFILE Staging
table. This skips records with a status of "Error Encountered.
"


Add Action Select the action to be taken for rows that can be loaded.


• Add New Record Only — Add ONLY new PROFILE
records into the system; do not overwrite existing PROFILE
records.


• Overwrite Existing Record — Add new PROFILE records
into the system AND update existing PROFILE records.


Load HHB Files (load non custodial
parent data files)


Select Yes to load non custodial parent data files.


Run Option Select one of the following:


• Single: Load only a single XML file


• File List Driven: If you have multiple XML files to load,
 you can combine them into a single load instance by using
File List.


Create a .TXT file that includes a list of the multiple XML
files you want to load and their corresponding source path.
 The PROFILE Import process reads the .TXT file and
searches for the listed XML files using the path defined in
the file list. If an error is found for a file in the list file, the
PROFILE Import process loads the previous files into the
database and then stops processing. The files after the file
in error are not processed. Use the message log to view the
files that the system loaded successfully or unsuccessfully as
well as any corresponding error messages.


Note: The Process Monitor can display the run status as
Success even when a problem occurs with the load process.
 To determine whether all files in a file list were successfully
processed, open the date-stamped list file and verify that its
content does not reflect an error in processing.


Note: Each PROFILE XML file must have a unique file name. If you attempt to load a record with a
duplicate file name, the PROFILE load process fails.


Related Links
Page Used to Set Up PROFILE Data Load Parameters


Copyright © 2018, Oracle and/or its affiliates. All rights reserved. 21







Processing and Using Institutional Financial Aid Applications Chapter _


Setting Up PROFILE Data Load Parameters
Overriding Expected Family Contribution (EFC)


Viewing PROFILE Load Summaries
The PROFILE Load Summary component displays the load status and other details of each record of the
file selected to review from the PROFILE Staging Table.


Access the PROFILE Load Summary (Financial Aid > File Management > PROFILE Import > Load
Summary > Load Summary).


PROFILE Batch Detail Records tab
Image: PROFILE Load Summary page, Batch Detail Records tab


This example illustrates the fields and controls on the PROFILE Load Summary page, Batch Detail
Records tab. You can find definitions for the fields and controls later on this page.


CSS ID (College Scholarship Service
ID)


Displays the unique identifier assigned to student by the
PROFILE system.


Bundle 50


Added Note.


Note: For the 2019–2020 Aid Year and forward, this field
displays the College Board Financial Aid ID value for
PROFILE.


Load Status Displays the Load Status of the record.


• Unprocessed — Record is loaded to PROFILE Staging table
but is not loaded to Inst App tables.


• Suspended — Record failed Search/Match or PROFILE Add
Level load rules.


• Processed — Record is loaded to application table.
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• User Delete — PROFILE Application Record has been
deleted by the user.


• Discarded — Record is not loaded because it is a
Noncustodial PROFILE or Registration Only record.


• Skipped — Record meets Search/Match and PROFILE Add
Level load rules, but there is an existing record and the load
parameter is "Add New Record Only" or the Review Status
is Complete on the Packaging Status Summary.


• Error Encountered — Scenarios in which status is
set include: Data Load Parameters not set, missing or
mismatched Aid Year, SSN invalid, SQL Error, and
invalid data in Search/Match fields. Status can be set by
user manually when an errant record is identified on the
PROFILE XML file.


Student's Admit Level Displays the student's admit level as associated with Academic
Program Statuses in the Defining Application Processing
Options, Working with Applications, Reviewing Admit Level
Associations page.


The values are:


• 5 - Accepted/Continuing


• 4 - Admitted


• 3 - Applied/Pending


• 2 - Inactive


• 1 - Has Not Applied


Application Type Bundle 50


Removed “Noncustodial PROFILE” and “Registration Only
Record”. Added “Canadian PROFILE”.


Displays the PROFILE Application Type


• Domestic PROFILE


• Canadian PROFILE


• International PROFILE


Student Record Type Bundle 50


Renamed “Original Data” to “Initial” and “(ACR )Additional
College Request” to “School Added”. Removed “Duplicate
Record”.
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Displays the CSS Student Record Type


• Initial


• School Added


HouseHold Type Displays the type of PROFILE application received:


• HHA – custodial parent application received.


• HHB – non custodial parent application received.


Merged HHA/HHB Displays if custodial parent and non custodial parent PROFILE
applications have been loaded:


• Yes – Both the HHA (custodial parent) and HHB (non
custodial parent) PROFILE applications have been loaded.


• No – Only one parent PROFILE application has been
loaded: HHA (custodial parent) or HHB (non custodial
parent) as indicated by the HouseHold Type field.


Update Status to Error Click this button to set the Load Status from Unprocessed
to Error Encountered. Records with a Load Status of Error
Encountered can be skipped during subsequent PROFILE Load
attempts.


Student Information tab
Image: PROFILE Load Summary page, Student Information tab


This example illustrates the fields and controls on the PROFILE Load Summary page, Student
Information tab. You can find definitions for the fields and controls later on this page.


National ID For United States students, displays the Social Security Number.
 For non-United States students, displays the student's country
and National Identifier or default National Identifier.


Dependency Status Displays Dependent or Independent
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Financial Aid Status Bundle 50


Renamed “First-time” to “New” and “Renewal Applicant” to
“Renewal”.


• New – Either a first-time applicant entering student or a
first-time applicant, continuing student


• Renewal — Continuing student


Load Information tab
Image: PROFILE Load Summary page, Load Information tab


This example illustrates the fields and controls on the PROFILE Load Summary page, Load Information
tab. You can find definitions for the fields and controls later on this page.


Suspend Reason • FA Term Not Built– At least one FA Term record for the
corresponding Year does not exist.


• Manual– Load Status set to Suspended manually by the user.


• Non-Unique Student ID Found – More than one student
meets the Search/Match criteria.


• Packaging Completed– Student's Aid Processing Status is
Packaging Completed.


• Student ID not Found– No student met the specified Search/
Match Rules criteria.


• Student Not Admitted– Student met the Maximum Search/
Match Level but failed the Admit Level.


• Student not at Load Level – Student ID found, but student is
not at the designated Admit Level.


Skip Reason • Final Review Flag Set — Review Status is Complete
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• Student Already Exists — PROFILE Load encountered a
matching ID despite the Add Action = Add New Record
Only; therefore, the student is suspended.


• Student Not at Suspend Level — Student fails Suspend
Level rule.


• Manual—- Load Status set to Skipped manually by the user


Alternate Institution Displays the Alternate Institution for PROFILE records
that were deleted by the user (status of User Delete) and
reloaded (status of Processed) to a different Institution than was
originally loaded.


PROFILE Staging Table Data tab
This tab displays links to view PROFILE data as it is received from the College Board.


Image: PROFILE Load Summary page, PROFILE Staging Table Data


This example illustrates the fields and controls on the PROFILE Load Summary page.


Managing Suspended PROFILE Records
Access the Profile Suspense Management Records page (Financial Aid > File Management > PROFILE
Import > Suspense Management > Profile Suspense Management).
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Image: PROFILE Suspense Management Records page


This example illustrates the fields and controls on the PROFILE Suspense Management Records page.
You can find definitions for the fields and controls later on this page.


Use the PROFILE Suspense Management Records page to review and manage unmatched, unprocessed,
and deleted PROFILE records.


CSS ID (College Scholarship Service
ID)


Displays the unique identifier assigned to student by the
PROFILE system.


Bundle 50


Added Note.


Note: For the 2019–2020 Aid Year and forward, this field
displays the College Board Financial Aid ID value for
PROFILE.


Alternate Institution Enter an Alternate Institution code to reload a user-deleted
PROFILE record into the Institutional (IM) Application tables
with a new Institution value. Displays only when the Load
Status is User Delete.


See Deleting PROFILE Records.


Load Status Displays the current status of the record. If the Load Status is
Skipped or Suspended, the field can be updated. If the status is
Discarded or User Delete, the field is view only.


Note: If you update the Load Status to Discarded, the Load
Status cannot be updated again.


Add Profile Select this radio button and click the Process button to load a
suspended PROFILE record into the application table.


Copyright © 2018, Oracle and/or its affiliates. All rights reserved. 27







Processing and Using Institutional Financial Aid Applications Chapter _


Note: Selecting Add Profile supersedes any Profile Routing
Control setup. Add Profile always adds the student into the
Institutional Application tables. Even if the student fails Search/
Match, because the Add Profile option is selected, the student
is added into the Institutional Application tables with a new
system-generated ID.


Note: Please refer to the decision matrix after the attribute
descriptions for this page to see how the ID, ID Lock, Add
Profile, and Recycle attributes work together.


Recycle Select this radio button and click the Process button to have the
PROFILE records reconsidered by the PROFILE load process
using the Profile Routing Control setup.


Note: Selecting Recycle always calls Search/Match. If Search/
Match fails, then the "Search/Match No Match Action" defined
in the Profile Routing Control is interrogated to determine the
next step:
If "Allow Add if Eligible", a new ID is created if the student
meets the criteria for adding a new record.
If "Suspend", the student's record remains in the Suspense
Management table.


Note: Please refer to the decision matrix after the attribute
descriptions for this page to see how the ID, ID Lock, Add
Profile, and Recycle attributes work together.


Process button After selecting the Add PROFILE or Recycle radio button, click
this button to invoke a real-time action to load the PROFILE
record into the Institutional Application (IM) tables.


Add Action Select the action to be taken for rows that can be loaded.


• Add New Record Only — Add ONLY new PROFILE
records into the system; do not overwrite existing PROFILE
records.


• Overwrite Existing Record — Add new PROFILE records
into the system AND update existing PROFILE records.


ID Select the ID to use to load the PROFILE record into the
application tables.


Note: Please refer to the decision matrix after the attribute
descriptions for this page to see how the ID, ID Lock, Add
Profile, and Recycle attributes work together.


ID Lock Select this check box after the selecting the ID to force the
PROFILE load process to use the ID as the matching person.
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Note: Please refer to the decision matrix after the attribute
descriptions for this page to see how the ID, ID Lock, Add
Profile, and Recycle attributes work together.


Max Match Level Found Displays the highest Search Match Level rule that was met for
this PROFILE record.


General Information Click this link to display general information about the student.


FNAR Messages Click this link to display FNAR messages.


Search/Match Click this link to access the Person Search Match page and
search for a student ID to match to the PROFILE record.


The following table is a decision matrix explaining the results of different combinations of the ID, ID
Lock, Add, and Recycle attributes on this page.


ID ID Lock Add Recycle Treatment


blank unchecked selected not selected Call Search/Match.
Assign record new ID if
no match found. Record
added.


blank unchecked not selected selected Call Search/Match.
 Based on PROFILE
Routing Control
parameters, record
added or suspended. If
added, assign new ID if
no match found.


blank checked selected not selected Search/Match not
called. Assign record
new ID, warning given.
 Record added.


blank checked not selected selected Search/Match not
called. Based on
PROFILE Routing
Control parameters,
 record added or
suspended. If added,
assign new ID, warning
given.


not blank unchecked selected not selected Warning given before
calling Search/Match.
 Record assigned new
ID if no match found.
 Record added.
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ID ID Lock Add Recycle Treatment


not blank unchecked not selected selected Warning given before
calling Search/Match.
 Based on PROFILE
Routing Control
parameters, record
added or suspended. If
added, record assigned
new ID if no match
found.


not blank checked selected not selected Search/Match not
called. Record added
with specified ID.


not blank checked not selected selected Search/Match not
called. Based on
PROFILE Routing
Control parameters,
 record added or
suspended. If added,
 record assigned with
specified ID.


Reviewing Institutional Correction Audits


This section discusses how to view institutional correction audits.


Page Used to Review Institutional Correction Audits
Page Name Definition Name Navigation Usage


Institutional Application
Correction Audits


INST_CORR_AUDITS Financial Aid > Institutional
Application Data > View
Correction Audits >
Institutional Application
Correction Audits


Review corrections made
to a student's institutional
application using the Maintain
Institutional Application
component. This page enables
you to track certain limited
changes that you make to
a student's institutional
application data.


PROFILE Application Delete SFA_PF_DELETE Access the PROFILE
Application Delete page 
(Financial Aid > File
Management > PROFILE
Import > Delete PROFILE
Records > PROFILE
Delete Utility > PROFILE
Application Delete).


Use this page to delete
PROFILE applications.
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Viewing Institutional Correction Audits
Access the Institutional Application Correction Audits page (Financial Aid > Institutional Application
Data > View Correction Audits > Institutional Application Correction Audits).


The system displays the student's name, ID, Aid Year, and Institution.


The system displays the following information relating to a change made to a student's institutional
application (PROFILE, Institutional, or Canadian): User ID of the person who made the change, the Date/
Time of the change, the application Source for the Old Value, the record and field name of what changed,
the original data—Old, and the changed data—New.


Changes are listed in reverse chronological order, by Record Name, then Field Name.


Deleting PROFILE Records
There are rare cases when a PROFILE record is accidentally loaded either to another student or to the
wrong Institution. There can be also cases where you specified the wrong EmplID (or similar severe
error) while manually adding a PROFILE application to the Institutional Application tables. You can use
the PROFILE Application Delete process to delete these erroneously loaded records. Running this process
deletes all corresponding Institutional application tables for the selected student for the specified Aid Year
and Institution.


Access the PROFILE Application Delete page (Financial Aid > File Management > PROFILE Import >
Delete PROFILE Records > PROFILE Delete Utility > PROFILE Application Delete).


Image: PROFILE Application Delete


This example illustrates the fields and controls on the PROFILE Application Delete page. You can find
definitions for the fields and controls later on this page.


Bundle 50


Added Note.


Note: The CSS ID column displays the unique identifier assigned to the student by College Board for the
2018–2019 Aid Year and prior Aid Years. For the 2019–2020 Aid Years and forward, this field displays
the College Board Financial Aid ID value for PROFILE.


You may delete PROFILE records for multiple students within an Aid Year in a single run of this process.
This removes PROFILE records from the PROFILE Application Records table.


The corresponding staging table data is not deleted and is assigned a new Load Status of User Delete.
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Using PROFILE Suspense Management, you can subsequently assign user-deleted PROFILE records
(those with a Load Status of User Delete) to:


• a different ID within the same Institution.


Note: If you assign a user-deleted PROFILE record to a different ID, be aware that the target ID's
CSS ID is updated with the CSS ID of the source PROFILE XML record, and the target ID is always
associated with that CSS ID moving forward. Also, the Update Biographic/Demographic data
attribute on the PROFILE Data Load Parameters setup impacts whether or not the target ID's bio/
demo data is updated in Campus Community.


• a different Institution.


When you assign a PROFILE record to a different Institution, you designate an Alternate Institution,
which is used as the key Institution when accessing the record in the Maintain Institutional
Application component.


Note: If you attempt to view or retrieve the original PROFILE record using the PROFILE Load
Summary search, you must specify the original Institution to which that PROFILE record was loaded.
However, the Load Summary > Load Information tab displays the (target) Alternate Institution.


Once a user-deleted PROFILE record is successfully processed (loaded into the Institutional Application
tables) for the corresponding Institution and Aid Year, that PROFILE record is no longer accessible using
PROFILE Suspense Management.


Related Links
Managing Suspended PROFILE Records
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